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Preamble
My name is Noos Foster. I was born in Craft World on July 12, 2012 and in Second Life on
July 29, 2012. Metaverses are very interesting 3d worlds that I have discovered last year.
With help of my Craft‘s friends, Licu Rau, Tao Quan, Salahzar Stenvaag, Rumegusc
Altamura, GeR Orsini, Beduino Ruben, Eva Noir and many others, I learned many things.
I write this guide for those who, like me, want to explore these worlds from scratch.
I have organized here many sources from internet and from my friends. Thanks all for the
support they have given me.

Introduction
(from www.opensimulator.org)
OpenSimulator is an open source multi-platform, multi-user 3D application server. It can
be used to create a virtual environment (or world) which can be accessed through a
variety of clients, on multiple protocols. OpenSimulator allows virtual world developers
to customize their worlds using the technologies they feel work best - we've designed
the framework to be easily extensible. OpenSimulator is written in C#, running both on
Windows over the .NET Framework and on Unix-like machines over the Mono
framework. The source code is released under a BSD License, a commercially friendly
license to embed OpenSimulator in products.
Out of the box, OpenSimulator can be used to simulate virtual environments similar to
Second Life™, given that it supports the core of SL's messaging protocol. As such, these
virtual worlds can be accessed with the regular SL viewers. However, OpenSimulator is
neither a clone of Second Life's server nor does it aim at becoming such a clone. On
the contrary, OpenSimulator lacks support for many of the game-specific features of
Second Life (on purpose), while pursuing innovative directions towards becoming the
bare bones, but extensible, server of the 3D Web.

Features
Supports online, multi-user 3D environments as small as one simulator or as large
as thousands of simulators.
Supports 3D virtual spaces of variable size within one single instance.
Supports multiple clients and protocols - access the same world at the same
time via multiple protocols.
Supports realtime Physics Simulation, with multiple engine options including
ODE.
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Supports clients that create 3D content in real time.
Supports inworld scripting using a number of different languages, including
LSL/OSSL, C# and VB.NET
Provides unlimited ability to customize virtual world applications through the use
of scene plugin modules.

Software architecture
As a demonstration of the power of this platform, it is coded in its default configuration
to be somewhat compatible with the Second Life viewer application, released under
GPL by Linden Lab.
Based on the original design of the Linden Lab network, there are five major services
which need to be provided to any region that wants to talk to the OpenSim viewer.
These services are known by the acronym UGAIM - User, Grid, Asset, Inventory,
Messaging.
User: This is the service responsible for authenticating the user to the grid. What
this means is that it is responsible for a very important task: it creates a session
identifier for the client which can be used to authenticate requests to the other
services in the same grid, and associates that session identifier with a UUID.
Grid: This is responsible for authenticating something else to the grid: the
regions. Because the grid is 2-dimensional, and because there are X,Y
coordinates that each region thus has, it is necessary to ensure that particular
X,Y coordinates are assigned properly (whatever 'properly' means to the grid in
question - but OpenSim's current default is to do two-way authentication with
the region services, based on a dual shared-secret scheme (called "incoming
password" and "outgoing password"). Each region is assigned a UUID.
Asset: This is essentially a WFRM database (write few, read many). Once an
asset goes in, there are two things that you can say about it: One, it's got a
UUID as a label... and two, it's in for life. Sounds, textures, images, notecards,
scripts, serialized inventory objects are added, and never modified again
(they're "immutable"). If you decide that you need to change a graphic to be
two pixels left of where it is for your virtual house's trim to look right, you have to
upload a new asset, which gets a new UUID, and associate that new UUID with
the texture. The old one stays there forever.
Inventory: That's all well and good, of course, but if it's all jumbled up into a keyvalue database like that, then what's the point? How could you keep anything
straight? The UUID may be great for a computer, but it doesn't have anything
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to do with a human-readable label - and how does it keep track of where I put
it? That's the job of a much different database services - one designed for a lot
of little writes and a lot of little reads. This is the Inventory services. It works by you guessed it - linking UUIDs together. The User has a UUID, which is used to get
his InventoryRoot folder's UUID, and the InventoryRoot has a list of UUIDs that it
links to, and each of those that are folders have lists of UUIDs, and those that
aren't contain a link to a UUID, a type, and a descriptive name for the asset.
The inventory service also retains permission information about items in
inventory.
Messaging: This one came later, and it's not quite as essential as the first four.
However, if you want the people using your simulator to be able to
communicate with each other via anything other than the creation of skywriting primitive letters, you need this. This keeps track of who's supposed to be
able to listen to whoever else, keeps track of long-distance messages sent from
one user to another (think 'SMS' for a real-world analogue), and keeps unread
direct messages until they're read (also very much like SMS).

All of these services are important, and because they're so important, they all share a
specific property: There Can Be Only One (of each, known to any given region).
Each of the services plays a very specific - and vital - role in the OpenSim system.
The Region runs physics, runs scripts (though this may one day be moved off of the
Region), keeps track of objects in the scene, keeps track of any observers connected,
and sends scene updates to all of the observers. To it, everything it knows about is a
UUID. Every last little thing - a user connected is a UUID, an observer is a UUID, its terrain
heightmap is a UUID, an asset is a UUID, a primitive is a UUID, the script running is a
UUID... get the picture? It's a glorified data processor.
A Region is, not to put too fine a point on it, a memory space and behavior simulator
which can share its state with observers. In short, it is a 3-dimensional MUD.
OpenSimulator will start up in standalone mode out-of-the-box on the binary
distributions.
An OpenSimulator configuration consists of regions (run by region simulators) and
backend data services (such as user, assets and inventory management).
A system running in standalone mode runs both the region simulator and all the data
services in a single process when you run OpenSim.exe. In this mode you can run as
many regions as you like but only on a single machine.
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In grid mode, the data services are not part of the region server process. Instead, they
are run in a separate executable called Robust.exe. A Robust shell can run all the
services or they can be split amongst any number of Robust instances. This allows them
to be run on entirely separate machines if necessary. In this mode, the OpenSim.exe
acts solely as the region server, serving one or more regions that communicate with the
separate data services. At this point you can run multiple OpenSim.exe region
simulators on different machines.

Page 7

OpenSimulator - Complete guide for beginners

Running in grid mode is more complicated than running in standalone mode. It requires
an understanding of UUID, X, Y location, server handshake passwords, estates and
estate owners, and a couple of other settings. These require more care and patience to
set up.
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Metaverse client viewers
Grids and viewers
There are hundreds of OpenSimulator-based virtual worlds out there. Many of them are
free to use and they welcome new users. If you would like to experience an
OpenSimulator-based virtual world before installing your own, try one of these.
My reference grid is Craft-World. You'll need to download an OpenSimulator
compatible client before connecting to OpenSimulator’s grids.
I use Singularity viewer for this guide, but there are other excellent viewer in the network.
If you want to use a lightweight viewer, written in C#, Radegast is an excellent choice.

Connect to a grid
The first thing you need to do is register you at the site of the grid you have chosen to
explore. For example, you can register yourself on Craft-World’s website.
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Most viewers have a grid selector. In many cases it’s always visible, and located at the
bottom of the login screen of viewer.

If your preferred grid is not present in the drop down menu, or if you want to update the
information from the grid, then you will have to make it manually. You will have to do
this only once.
First, find the grid manager. Press Add button and the only fields that you will have to fill
in are:
Grid Name (or alike) - A name you can easily identify the grid by. OpenSimulator grids
don't use this information, so you can name it anything you like.
Login URI - The most important information that you can find on the grid’s website. For
example, for Craft World, this is "http://craft-world.org:8002".
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1
2
3

Then, press the Apply button. If you click it, it may fill out several blank fields with URIs. In
some cases, clicking the button will cause an error message to pop up, or in rare cases,
freeze the viewer. If clicking the button causes problems of any kind, you can leave the
remaining fields empty, or find the missing info and add it manually. Leaving the fields
empty will normally not cause problems, and you will still be able to log in to that grid,
although on some grids, some features may be unavailable until the missing info is
added.
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2
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Then click the "OK" button to store your new grid in the menu, and you will be ready to
log in. Then simply enter the username and password that you chose when you created
your account on that grid, and click the "Log in" button.

1

2

3
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Avatar movements
When you are connected to the grid, you can see your avatar waiting for you to do
something.
You can move the avatar on the floor with the arrow keys of your computer.
Mouse wheel as a zoom from third person to first person camera.
You can also display two panels from the View menu, which will show you many more
commands to move your avatar in the world.
Movement controls panel allows you to move the avatar around the world.
Camera controls panel let you change the point of view of the character.

There are also other special possibilities. Below you can see the Fly button. This mode
allows you to move faster through the world.
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You can find many other commands for avatar’s movements at this link:
http://wiki.secondlife.com/wiki/All_keyboard_shortcut_keys

Communications
In Opensim communications between avatars are very important parts. There are
several ways to communicate between avatars.
Chat
If you want to say something so people around you can hear it, you can simply write in
the lower dedicated area of viewer.
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What you write is shown in this way. What nearby avatars write in chat is shown in this
way.
You can see that only the last lines of chat remain visible on the screen. If you want see
all the phrases of chat you can press the Local chat button.
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Friends and groups
When you meet another avatar in the world, you can ask him to be your friend.
To do this, you must place your mouse over the character, press the right mouse button
and choose the option Add Friend…
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You can view your friends from Communicate button by choosing Contacts tab.

2

1

When you become friend of someone, you can see when they are connected and for
example you can offer him a teleport to you. You can set some permissions for your
friends. For example you can choose if your friends can see where you are, or if they
can change your inworld creations.
You can also join groups. If you write on chat group, all members of the group can read
your posts.
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Instant messages
You can start an instant message session with a friend. An IM is a private
communication between you and your friend or a members of a group. If your friend is
offline you can also write an IM, and when he reconnects he will find your message
even if you are disconnected.

Obviously, you can write an IM even if your partner is far away from you.

Avatar world interactions
In Opensim, in addition to interact with other avatars by chat or IM, you can interact
with the world's objects in various ways.
You can touch an object and it can activate a specific function. For example, if you
touch by clicking a door, it can open itself.
You can also collide to the objects and unleash some functions.
Finally you can use the menus. Place your mouse over an object, press the right mouse
button and see available standard options. Some objects show also their specific
command in this menù.
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Functions can animate objects, but also the avatar, changing its position or by doing
something to him. In this cases, when the option is chosen, the avatar may request
authorization to be animated from the object, and then does what he must do.

Around the world, you can find “Pose ball” that allow you to animate your avatar in the
way they described.
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Map, teleport and landmark
Virtual worlds can be very large. Sometimes orient itself is not easy. In a grid there are
many sim, and they are often scattered. Each one is unique and is important to know
how they are made for your orientation.
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The viewer has a world map inside. To view the map you need to click the Map button.
The panel on left shows a map where you can see the places and the location of sims
and other avatars, and on the right shows a series of commands.

If you click a point on map, if you want you can teleport you to that place, using
Teleport button
When you're in a place that you like, you can store in your inventory a link to that place
to be able to go back again another time by using a teleport.
In World menu there is a command to create and save the link I said.
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Buy object
In virtual worlds, as in the real world, you need to have clothes and objects for living.
In the stores present in the sims, you can buy items and clothing.
In grids as Craft World cost of items is zero, but it isn’t always so.
In Craft World grid there isn’t money, but you can still buy an item, which will always be
free.
If you put the mouse pointer over an object and the money’s symbol appears, you can
buy it by clicking it.
Otherwise, you can press the mouse’s right button and use the Buy menu.
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In a window, you can see the list of items that you buy and their cost.
By pressing Buy button you purchase the items. They will be copied to your inventory.
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Inventory
Each avatar has an inventory where he stores all objects that he owns. In inventory
there are objects created by us or purchased. You can organize your objects, you can
wear them, sell or delete them.
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Snapshot
At any time you can take a photo of what you are seeing and store it in inventory, save
it in your computer or send it by email.
The button to do this is located next to the Fly button and it’s called Snapshot.

Personalize avatar
An avatar is your image in virtual worlds. You must change the initial avatar, so it will be
unique and will represent you.
Shape and skin
You can change the gender, the shape and proportions of the character, by changing
some parameters.
Click with the mouse’s right button on your avatar and choose the Appareance option.
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To change avatar proportions on Inventory, right mouse button, New body parts, New
shape.
Choose the Shape tab, and then Body. If you adjust the values displayed, your avatar
will change the shape of his body.
When you change a value, your changes are made immediately on avatar. You can
move avatar while making changes.
Click mouse’s left button and move your mouse. Orizontal for rotating model, and
vertical for zoom model.
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You can do the same for all values of the shape where you feel need to make
changes.
After this, press Save As button to save your combination with a name in inventory.
When you wear this combination, the avatar will take the shape you've created. You
can double-click on the saved combination to wear it.
You can also draw the skin of the avatar. The skin is composed of three images, which
are wrapped on body shape.
Below the templates of three images. You need to work with image editing software to
get the skin you want.
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When you have prepared the images, in viewer choose for each:
File -> Upload -> Upload image
Now choose, edit Appareance of avatar’s menu.
Select skin tab, then Skin color button. Click on Head Tattoos, Upper Tattoos and Lower
Tattoos square and select the updated images from Inventory.
After this, press Save As button to save your combination with a name in inventory.
In equal mode, set Hair and Eyes texture if you want.
Clothes
There are two ways to make clothes. Now let's try one that uses only images.
Each cloth is composed of an image and a few parameters.
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You can use skin’s template to draw the cloth, as in the example below.

If you want to draw a skirt, you need a new specific template.
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When you have prepared the image, as you have done to the skin, in viewer choose:
File -> Upload -> Upload image
Choose, edit Appareance of avatar’s menu.
Select one of clothes tab, then select the updated image from Inventory and set the
appropriate parameters.
After this, press Save As button to save your combination with a name in inventory.
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In the same mode, you can upload and create some default clothes: shirt, pants,
shoes, socks, jacket, gloves, undershirt, underpants, skirt, boby tattooes and alpha
image.
Outfit avatar
When you're done to customizing all parts of your avatar, you can create a unique link
to wear all the objects needed to obtain a desired appearance. To do this, use the
Make outfit command.
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Undress clothes
You can replace an object worn by choosing another object to be put in the same
place, or you can undress objects or clothes, using the special commands in the avatar
menu, as shown below.
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Avatar profile
Finally, each avatar has a personal profile, where you can put some useful information
to others. You can access this window by using the specific command in the avatar’s
menu.
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Inworld content creations - Building
Introduction
Everything in OpenSim is made of prims, with the exception of the terrain, the avatar
(even though prims can be attached to it) and meshes (which are still relatively new). A
prim is short for primitive, and means the very basic “building brick” objects consist of.
There are nine different kinds of prims – Box, Cylinder, Prism, Sphere, Torus, Tube, Ring,
Plants and Sculpted. With the exception of the Sculpted Prim, all of these can be
created in-world.
In OpenSim is very easy to create objects. Let's see the basic operations using Linda
Kellie’s guide.
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Inworld building tools
(from http://wiki.secondlife.com)
The Second Life viewer has built in tools to create and modify objects, a process known
as "building". Once created, objects can be stored in your personal inventory, shared
with other users, or placed somewhere within the 3D world.
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Objects are made of one or more "primitive shapes", or "prims", which can linked
together to form more complicated items. Each prim has one or more images called
"textures" applied to its surfaces, and can contain an unlimited number of items inside it,
including other objects.
The items placed inside an object can include software scripts, animations, sounds, and
additional textures. These can make an object perform an almost unlimited number of
actions.
Opening the Tools
There are five build tools selectable either from the top menu or within the Tools
window: Focus, Move, Edit, Create, and Land. Within the window, the five icons along
the top will change tool selection. The bottom portion of the window has five tabs
which work with the edit tool to change a selected object.
Any of the following will open the Tools floating window. Note the Tools window has no
title. You must have permission to create new objects on the land parcel or edit an
existing object for the tools to work. You should also be familiar with the camera
controls to build effectively.






Top menu View > Build
Top menu Tools > Select Tool > (any of the five tools)
3D view right-click an existing object Context Menu > Edit which will select that
object for editing.
3D view right-click on an existing object or on bare land Context Menu > Create
which will create a new object at that location.
If local chat is closed, keyboard B.

You can click-drag on any empty part of the window to move it to a different screen
location.
Focus Tool
This tool changes where the camera is looking in the 3D view. Selecting this tool will
change your mouse pointer to a magnifying glass. Clicking any point in the 3D view will
center that point.
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Zoom - Using the scroll wheel or slider will zoom the view in or out.
Orbit - Click-drag will rotate the view around the selected point. This option can
be selected temporarily by holding the Ctrl key.
Pan - Click-drag will slide the view parallel to the current viewing plane. This
option can be selected temporarily by holding Ctrl + Shift.

Move Tool
This tool moves a selected object smoothly. Selecting this tool changes the mouse
pointer to a hand.





Move - Click-drag will move the object smoothly in the horizontal plane.
Lift - Click-drag will move the object smoothly parallel to the current viewing
plane.
Spin - Appears to work the same as Move.

Edit Tool
This tool edits the details of an object. Selecting this tool changes the mouse pointer to
an arrow with a crossed axis symbol. Clicking an editable object will highlight the object
with a yellow outline for the "root prim" and a blue outline for any other prims, and show
edit axes and coordinate values on the screen.
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Position - The axes are color coded: red for X (east), green for Y (north), and blue
for Z (height). The axes are centered on the center of the object, which gives it
it's "location" measured in meters from the bottom south west corner of the map
region. An object is considered "in" a region or parcel if it's center point is within
the boundaries, even if part of it overhangs. There are small arrows at the
intersection of the axes, which when click-dragged will move the object along
that axis. There are two-color triangles near the arrows, which when clickdragged will display a grid and move the object within that plane.
Rotate - Also selected temporarily by holding the Ctrl key. Changes the axes to
three rings. Click-drag on a ring will rotate the object along that plane. Sliding
outwards will show a circular ruler, which will rotate the object in 1/64th of a
circle (5.625°) steps.
Stretch - Also selected temporarily by holding Ctrl+Shift keys. Changes to small
cubes on the sides and corners of the object. Click-drag of a colored cube will
stretch the object in one dimension. Clicking the grey corner cubes will stretch
the object in all three dimensions, with the opposite corner staying fixed.
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Select Texture - Shows a white target on each side of the object. If unselected,
texture tab will apply to all sides of the object. If selected, changes will apply to
one side at a time. You can click-drag a texture from your inventory to apply.
Edit linked parts - Lets you select one prim of a multi-part linked object for editing.
The single prim will be outlined when selected.
Ruler: - When the use grid option is checked, affects the numbers that appear on
the rulers. World will show the region coordinates, Local will show 0 as the current
location, Reference ???.
Stretch Both Sides - When checked, using Stretch on a single prim will extend
opposite sides rather than just the one side.
Stretch Textures - When checked, will stretch the textures on the object. When
unchecked textures remain the same size as the object changes.
Use Grid - When checked, shows rulers parallel to the axis you are changing
position for. If you drag mouse over the ruler, the object will jump to the nearest
tick mark on the ruler rather than moving smoothly. If you drag near the axis line
between the rulers it will move smoothly.
Options... - This button opens the Grid Options window, so you can adjust the
ruler.
o Grid Unit (meters) - Sets the major grid unit tick mark spacing.
o Grid Extents (meters) - Sets the overall length of the rulers when zoomed
out. When you are zoomed close to the object, the rulers are truncated.
o Enable Sub-Unit Snapping - Shows smaller tick marks between the grid unit
marks for smaller jumps as you move the mouse.
o Show Cross Sections - Shows transparent cross sections of the object
perpendicular to the edit direction to help with alignment.
o Grid Opacity - Varies the transparency of the grid rulers from transparent
(left) to opaque (right).
Selected objects: - The number of objects you have selected currently, where
linked items are counted as one object.
primitives: - The total number of prims included in the selected objects.

General Tab





Name: - A newly created object has the default name "Object". This box lets you
change it to any other name up to 63 characters long.
Description: - Blank by default. You can enter up to 127 characters of text here.
Creator: - Shows the original creator of the object, with a button to open their
profile.
Owner: - Shows the current owner of the object, with a button to open their
profile window.
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Group: - Shows the group name assigned to the object. By default it is set to the
same group as the active group of the creator. The Set... button allows changing
the group assigned. The group assignment affects whether an object can
remain on a parcel and who can use it.
Permissions: - Second Life has a permissions system to control how people use
objects they did not create. The original creator has full permissions to copy,
modify, and transfer the item, but they can restrict subsequent users from some
or all of these abilities. Note: the contents of an object can have different
permissions than the container, and copies may inherit different permissions than
the original.
o You can (cannot) modify this object - Indicates whether you have rights to
change the object. Even if you cannot change it, normally you can take it
in and out of your inventory, and if it is a wearable item, edit how it is
attached to your avatar.
o Share with group - If checked, any member of the group listed above can
use the object.
o Deed... - Opens a window to make the item group owned.
o Allow anyone to move - If checked, any user can move the object.
o Allow anyone to copy - If checked, any user can take a copy of the
object for their own.
o Show in search - If located on a land parcel which is listed in search, the
object will also be listed in that search result page.
o For Sale - If checked, the object can be bought by other users. When
checked, the price box becomes active, and you can set any price,
including zero. The three buttons allow selling the original item, a copy
with all contents, or just the contents and not the container.
Next Owner Can: - Sets the user permissions for the next owner.
o Modify allows editing any part of the top level object's features with the
edit tool except adding more permissions. The permissions of the contents
may be different and not allow editing them internally, though they can
be removed or added.
o Copy allows making an unlimited number of copies of the object.
o Resell/Give away (known as "Transfer" by most people) allows you to
transfer the object to any other user.
When Left-Clicked: - Changes the default action when someone clicks on the
object.

Object Tab
This tab allows you to edit the size, shape, and location of an object. Most objects start
as simple geometric block selected from the Building Block Type dropdown list. The
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default shape is a 0.5m cube. The Sculpt type is defined by a texture map and can be
a fairly complex shape but still only be one prim. See this 3D modeling guide for
detailed information.












Locked - When selected prevents you from moving an object.
Physical - If not selected, objects ignore the physics simulation. For unscripted
objects, they will stay in one location, unaffected by gravity or collisions. If
selected, objects will fall and move if hit by something else.
Temporary - If selected, the object will disappear after a short time.
Phantom - If selected, the object can be walked through or penetrated by other
objects in motion.
Position - The location of the object center in map region coordinates X (east), Y
(north), and Z (height) in meters. Using the number entries here rather than
moving with the object axes allows more accurate positioning. The maximum
values are 256 for X and Y, and 4096 for Z since that is the size of a map region.
Size - The X, Y, and Z size of an unmodified building block. Various distortions on
the right side of the tab will affect the actual size. New objects are limited to 10
meters in each dimension. So-called megaprims were originally created via
loopholes in the software with dimensions larger than 10 meters. If you attempt to
edit the size of a megaprim, it will revert to 10 meters. In other respects they can
be edited normally.
Rotation - The rotation of the object clockwise around the stated axes in
degrees. X and Y are limited to -180 to +180, and Z is limited from 0 to 360.
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Material - Affects how the object reacts to gravity (mass) and collision sounds. It
does not affect how it looks.
Building Block Type - Lets you change the basic geometric shape.
Path Cut Begin and End - This is a vertical slice removed from the basic shape,
the way a cake or pie is cut in real life. The numbers define a starting and ending
angle for the cut using a scale of 1.000 for the complete circle.
Hollow - The size of a center hole in the object in percent of the full X and Y
dimensions. The hole is aligned with the Z axis when the rotation is 0. Rotating the
object will point the hole in a different direction. The value is limited to 0 to 95
percent.
Hollow Shape - Default will make the hole match the basic shape of the object.
Twist Begin and End Taper Top Shear Slice Begin and End -

Features Tab
This tab applies optional features to an object.

Flexible Path - When checked, the object becomes flexible rather than rigid, and
behaves according to the 8 parameters listed below. The parameters have arbitrary
scales. The base of the unrotated object stays fixed while the rest moves.
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Softness - Controls how 'bendy' the object is. Range is 0 to 3.
Gravity - Controls how hard gravity pulls downward on the object. Negative
values pull up. Range is -10 to 10.
Drag - Controls how much viscous drag (or friction) the object appears to have
when moved. Range is 0 to 10
Wind - Controls how much the object bends in response to local map region
winds.
Tension - Controls how much 'force' is tugging the object away from it's base.
Range is 0 to 10.
ForceX - Controls how much 'force' is applied in the X (east) direction. Range is 10 to 10.
ForceY - Controls how much 'force' is applied in the Y (north) direction. Range is 10 to 10.
ForceZ - Controls how much 'force' is applied in the Z (up) direction. Range is -10
to 10.
Light - When checked, the object emits light to the surrounding area. This is
separate from glow in the Textures tab.
Color - When the box is clicked, a Color Picker floating window opens to select a
color for the light.
Intensity - How bright the light is.
Radius - The distance the light extends, in meters.
Falloff - How fast the light fades from the center.

Texture Tab
Textures are the images applied to object surfaces to make them look like something
besides a plain grey shape. When an object shape has loaded, but not the texture it is
shown as grey.
Texture sizes are forced to be power-of-2 dimensions (64, 128, 256, etc pixels)in each
direction for efficiency in graphics memory. Maximum size for a newly created texture is
1024x1024. A few legacy textures are larger.
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Texture - Clicking this box will open the Pick: Texture floating window, allowing
you to select a new texture. Alternatively you can drag a texture from your
Inventory window to the box, or directly to the object. If the Select Texture item in
the upper pane of the Tools window is selected, you can change one side at a
time of the object. Otherwise texture changes are applied to all sides at once. If
an object uses more than one texture, the word Multiple will appear in this box.
Color - Clicking this box will open the Color Picker floating window. Color tints
selected are additive to the color of the base texture. This means it will be darker
or more strongly tinted.
Transparency - Uploaded textures may be RGB colored, or may contain a fourth,
alpha, channel which defines transparency. This setting applies an overall
transparency to the texture in addition to any transparency in the alpha
channel. The range is 0 to 90 percent.
Glow - This item creates a surface glow on the object, separate from the light
emitted with the Features tab. The range is 0 to 1, but any glow above 0.1 tends
to wash out the surface texture.
Full Bright - If checked renders the object as if fully day-lighted, regardless of the
environment day cycle position of the sun.
Mapping Shininess - Gives the object an apparent gloss or matte appearance.
Bumpiness - Gives the object an apparent bump map shading in addition to the
texture.
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Repeats Per Face - Controls how many times the texture is repeated on one fact
of the object. Range is 0 to 100 in each axis, and can be flipped in both axes.
Rotation - Controls rotation of the texture relative to vertical. Range is -360° to
360°.
Repeats per Meter - If a value is used here, the texture is applied according to
the object size, rather than a number of times per face. Range is 0.1 to 10.
Offset - Shifts the texture horizontally and vertically relative to the object surface.
If the texture is rotated, the shift is along the texture, not the object face.
Align Media Texture –

Content Tab
This tab shows the internal contents of the selected object. An object can contain any
type of inventory item, including other objects which in turn have nested contents.
There is no set limit on the number of items that can be placed inside an object, though
if it in the hundreds, it can take some time to fetch or edit the contents.



New Script - When objects are located in a map region, any active software
scripts inside them are run by the host server. This allows objects to perform a
wide variety of actions. Objects stored in your inventory are not actively run. This
button will open a new Script window for editing. Scripts are written in a "C++"-like
"Linden Scripting Language" (LSL), which has many functions specific to Second
Life. Objects may contain multiple scripts. See the LSL Portal for details. Scripts
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can also modify the inventory contents of prims that contain them, see Inventory
for details.
Permissions... - Opens the Bulk change content permissions window. This allows
you to mass-edit item permissions. Note: you cannot grant yourself more
permissions than you started with for the items.
The main list box - Items are listed in alphabetical order, without regard to
inventory type. If an item has limited permissions, it will say (no copy), (no
modify), or (no transfer) after the item name. Clicking an item will highlight it, and
right-click will bring up a context menu. Editable items (notes and scripts) can be
opened while inside the container. Items may be dragged from inventory to this
list, or from this list to your inventory.

Create Tool
This tab allows you to create a basic geometric shape (prim). The mouse pointer
changes to a magic wand when this tool is active. Clicking one of the shapes in the
tool, then clicking somewhere in the 3D view, will create an object at that location.
New objects are 0.5 meters in size and have a plywood texture by default. The last two
items, trees and grass, can only be used by the landowner. The others can be used by
anyone with building permission on the land parcel.
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Each land parcel has a limit to how many prims it can contain in total. If this limit has
been reached, you will get an error message if you try to add another item.






Keep selected - If not checked, after creating a new object, the window will
change to the edit tool so you can edit your new object. If checked the window
will stay on this tool so you can make more items.
Copy selected - If checked, will create more objects of the selected type, and
align them touching the face of where you click next.
Center Rotate -

Land Tool
This tool lets you modify the land parcel itself as opposed to objects located on the
land. Selecting this tool will change your pointer to a bulldozer.
A land parcel shares part of the terrain map for the region it is located in. The top
portion of this tool allows you to reshape the terrain within the Limits for the region and
adjoining land parcels. The terrain map is continuous, meaning you cannot tear holes in
it. So any changes you make to one part of it will smoothly connect to neighboring
parts.
Estate owners can also change the texture (images) for the surface, by changing the
terrain map. External tools exist to edit it. Some special plants are created internally in
the viewer software, and only count for one prim each. They can be found in the
Library part of your inventory. Other plants are normal objects.
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Select Land - The first button is used to select an area via click-drag across the
land in the 3D view. A yellow outline will appear to show your selection. The other
buttons will then give you the option of applying the change to the whole
selection using the Apply button, or using the Bulldozer to adjust areas as you
click-hold over them. Arrows will appear over the area you are working on, and
the longer you hold the mouse button, the more the land will change. The Size
and Strength sliders control how effective the bulldozer is.
About Land... - Opens the About Land floating window to see or edit the parcel
information.
WARNING: The following three buttons will cause loss of parcel settings in the
About Land window, and may cause loss of search listings, traffic score, and
landmarks may fail.
Subdivide... - Opens Subdivide Land window to break selected land area into a
separate parcel.
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Join... - Opens Join Land window to join parcels. Any parcels you own that have
parts in the selected area will be joined. It is not necessary to select the entire
parcels.
Buy Land... - Opens Buy Land window to "buy" a land parcel. See the discussion
there about how this is not an actual purchase, but payment for services.
Abandon Land... Opens Abandon Land window to return land to the region
owner (Linden Lab or Estate owner). Note it is often better to sell than abandon a
land parcel, since you get no payment when you abandon one.

Build and edit object
(from http://opensim-creations.com)
To create a prim, click on the “Build” button on the bottom of the screen. Your cursor
will change to a magic wand and you will see a window appear. On the top you can
see several 3D-shapes. These are the basic prim shapes you can create instantly. You
notice that there are actually more than nine different shapes; that is because some of
these basics are actually variations of the same kind of prim. (For example, the pyramid
is a modified box.) Click anywhere on the ground with your magic wand and the
according prim will rez there. On rezzing it, your cursor will change back to a pointer,
and the edit window will change from rezzing mode to edit mode (the buttons on the
very top of the window are the different modes the inworld editor can be in).
The edit mode has several submodes; by default it shows the “general” tab. Clicking on
the “Object” tab allows you to change the various aspects of your prim. This is the main
tab you will need for building, and the one we will cover for now. In it, you can change
the basic type of prim again by clicking on the dropdown menu saying “Building block
type”. Apart from that, you can change many different aspects of the prim, giving it a
different shape overall. Note that the variables you can edit vary from prim type to prim
type.
When you’re new to building, you should first familiarize yourself with the different types
of prims, because when you want to build something, you should start with a prim that’s
similar to what you would like to make. We want to make a table, so we will start with a
box, since boxes are square and have flat surfaces, just like a table.
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Before we edit the box, let’s first have a closer look at our workspace. When you create
something, you should do it in a peaceful and relaxed environment that is free of other
objects that could get in the way. I recommend devoting a blank region just for editing,
or at least make some kind of sky platform that’s far enough from everything rezzed on
the ground. The reason for this is that many times you’ll need to select prims with a
selection box, and objects close by will get selected along with it, making the whole
process a mess.
You will notice that I have several other windows open besides the edit window. I
usually keep the inventory open at all times for easy access. Additionally I keep a small
statistics window (View > Statistics Bar) open to have an eye on sim performance, and
the Minimap to have an eye on the things around me. All of that can prove useful – the
sim statistics help showing when your connection broke off the inventory lets you easily
get to items you might need and the minimap helps you keep an eye on your
surroundings while you’re focussing on something on the ground in front of you.
Now the basic rule about building is: Don’t lag. Lag is experiencing a delay in actions
when using a software. This is a broad definition, so I’ll break it down to what’s relevant
for us. In OpenSim/SL we distinguish between server side and viewer side lag, and the
difference is important.
Server side lag occurs when the server OpenSim (or the SL equivalent) is running on –
the server that handles all the prims and avatars and sends the data packets to your
viewer to render the world for you – is overloaded and can’t handle all software
requests fast enough to simulate a ‘smooth’ flow. You can see server side lag on your
statistics window; usually Sim FPS is 45 in SL at all times, and around 50 to 60 in OpenSim.
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If it drops, it means the simulator is busy handling requests and the results will be
‘snapbacks’ when you try to move, or a delay in rezzing things / transferring inventory,
and a delay in chat messages appearing in local chat and / or IM. Server side lag
usually happens when a lot of things are happening on a region that are demanding of
system ressources on the server side.
The most resource intense modules are the physics and script engine, so a lot of scripts
running on a sim (either in rezzed prims, or avatar attachments) will draw ressources
from the server through the script engine, or physical prims, vehicles and avatars are
drawing ressources from the physics engine. Avatars are also drawing ressources from
the server simply by requesting data packets about the scene when entering a region,
so avatars are always the one source creating most lag. It’s not always easy to
determine the source of server side lag, since there are many things drawing system
ressources that aren’t readily apparent. For example, few people actually know how
many scripts their attachments have or if what they do uses the physics engine, so we,
as creators, need to think about this beforehand. This means: Where possible, use a
scriptless solution, turn prims phantom if they don’t need to be solid, and don’t use
physical prims unless you absolutely have to. It also means you should build in a
secluded location that doesn’t have many avatars on it. A private region would be
optimal, while sandboxes – contrary to their intent – are usually very bad places to build
at; they tend to be crowded with avatars and leftover prims that can get in your way.
Viewer side lag happens when the viewer software can’t render a scene fast enough
even though the server sends all the data fast enough. This issue is even more
complicated, since a lot of it depends on your hardware. Generally, the better your
hardware, and most of all, your graphics card, the more FPS you can get. Again, the
stats window will show you the framerate, this time right at the top. Still, certain things
are more demanding of your graphics card than others, and while you as a creator
might have a great card, people who use your creations might not, so you again
should try to avoid causing lag in your creations for them. The things that cause the
most viewer side lag are (in order of severity): Sculpties (and probably meshes, but
that’s not tested yet), particles, large textures, flexi prims, shiny prims, coalesced prims
(to some extent) and physical/moving prims (again). Sculpties are very lag intense,
since they render differently (and more precise) than regular prims. Particles can be
nasty if there are many of them, or if they’re physical, or use high-res textures. Large
textures are textures that are of an unnecessary high resolution. Usually a texture of
512×512 pixels is sufficient for almost all uses, except for very large (region-spanning)
prims or for avatar layers. Alpha textures are textures that are partially transparent. They
cause lag because the part that is visible “behind” them needs to be calculated not
only along the borders of the prim they’re on, but for every pixel of the texture
individually. Flexi prims, like every other constantly moving object, require a steady
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recalculation of their properties, thus keeping the graphics card busy at all times. Shiny
prims are somewhat resorce intense since they need to render the shine on top of the
shading, which, especially in sculpts, can be very laggy. Coalesced prims are prims that
are intersecting each other, which means the intersection line needs to be calculated
on top of the prim vertices, causing some more rendering weight for the graphics card.
And finally, physical prims cause some lag because they need to be recalculated for
each frame again as they move.
Now you might have noticed I didn’t say anything about the number of prims. This is
because everything is depending on the amount, but a lot of prims doesn’t
neccessarily result in a lot of lag, it more depends on the kind of prims used. The above
explanations on lag don’t mean that you should never use lag intense prims / resources,
but should rather take that into consideration and avoid it, if possible.
Back to our table, which is still a cube. A good way to start building is always to move
the object to an ‘even’ position on the region grid. To move a prim, right-click it and
chose “Edit” if you’re not already in edit mode. You will see a cross of three arrows
(green, red and blue) pointing into the three dimensions of space. Move your
mousecursor over an arrow, and it will get a little larger; clicking and holding your
mouse cursor on that arrow will enable you to move the prim into the according
direction. When you click and hold, you will see two white lines lining the sides of the
arrow with small vertical lines intersecting. This is the grid ruler. You can adjust the length
of the steps by clicking “Build Options” in the edit window. I recommend units of 0.050
m (5 cm), which is a good value for almost any building. If you’re building very small
objects (like jewelry), you might need to use even smaller steps.
These grid units are very useful for building, because they allow you to ‘snap’ the prim
to exactly that position. If you just move the prim along the arrow, it will move freely,
and the position will almost always end in an odd number, but when you click and hold
the arrow and then move the mouse a little to either side of the ruler, you will see the
object jump from grid unit to grid unit, thus allowing more precise editing. This same
technique applies to the other prim editing tools (rotating and scaling) as well. For our
example I placed the prim at 128/85/44 (meters in X, Y and Z direction).
Now, our prim is still quite small to be a table, measuring only 0.5 meters in either
direction. So we want to stretch it a little. The easiest way to do it is to hold down ctrl
and alt while having the prim selected. You will see blue, green and red dots on the
center of either surface of the prim, and white dots in the corners. Pulling (click, hold
and drag) on the coloured dots will stretch the prim in the according direction, while
pulling the white dots will scale it as a whole (in every direction).
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We want to stretch it. If we stretch it into a certain direction, it will, however, not center
on the position we just moved it to anymore. The solution to this is to check the box
“Stretch both sides” in the edit window. This means our prim will stretch both into the
direction we pull to and the opposite direction, thus keeping its center. Now stretch it
with either of the white dots until it is exactly 2 meters big. Remember the ruler;
additionally, you can see the three values of your prim on the center top of your
screen.

Now as explained above, we want to build lagless. Thus, it’s neccessary to only use as
many resources as neccessary, so you should try to build with as little prims as you can.
(This is especially true for Second Life, where people can’t rezz many prims on their
lands and therefor will usually opt for something low-prim). This means, we need to use
some tricks to keep the prim count low.
The trick we will apply for now is prim cutting. Because in addition to moving, rotating
and scaling prims, there are several other parameters you can change about it. Switch
to the object tab in your edit window if you haven’t done so already and take a look at
the different boxes there. To get some idea about what is possible with these you will
need to spend a lot of time playing with them and the different prim types, so I won’t
explain all these in detail here. What we want, though, is to hollow the prim. The hollow
parameter is a percentage, we raise it to 85.
Our prim has now a big hole in its center. The shape of the hollow can actually be
changed, but with the box it’s square by default, and we will leave it like that. Still, the
box looks not very table-like this way so we rotate it along the x-axis by 90 degrees. To
rotate a prim, hold down ctrl while it’s selected. You see three rings around the three
axes; pull at the red one to rotate around the x axis. Again, use the ruler to get to
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exactly 90 degrees. The next step is to cut the path. Change the values for “Path cut
Begin and End” to 0.125 B and 0.625 E. Finally, rotate the prim 90 degrees around the y
axis.

Now our prim already looks like a table – albeit a modern art version of a table, and
while this might fly with some people, most might expect a little more from it than it
being cubic. However, we can use this for table legs, but we need to compress it a
little. This time, though, we don’t want to keep the center of the prim, since table legs
are on either side of the table, so uncheck “Stretch both sides” in the edit window, then
hold down ctrl and alt and pull at one of the blue dots until the prim is 0.2 meters long.
Now we already have a pair of table legs, and need another pair on the opposite end
of the table. To do that, you can simply copy the prim by selecting it, holding down the
shift key and dragging it to a new direction. Drag the prim about 2 meters away. (In
fact, the first table legs will be 0.9 meters from the original prim center, so the second
pair of legs should be 1.8 meters away from them, or 0.9 meters from the original center
in the opposite direction.)
To finish the table, we need a table top. Rez another box and move it to the original
center of the prims, then change its dimensions to 2.2, 2.2, 0.2 meters. Then move it
upwards until it sits on the table legs. This time, our object looks a lot more like a table,
and still only uses 3 prims (while it would use 5 prims if we would’ve made the legs from
individual prims). It’s important to have prims extend beyond the borders of other prims,
in order to keep their surfaces from overlapping, because when several prims have their
surfaces on the same coordinates, it creates an effect known as Z-fighting, meaning the
surfaces will flicker, which is stressful to the eye and doesn’t look particularly pretty. In
the above snapshot the vertical surface between every leg pair is close to the lower
surface of the table top, so it would be better to either move the top a little more
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upwards (creating a vertical board under the surface of the table) or downwards
(sinking it into the table top).
You see it is important to keep things in proportion. If the legs would be too thin, or the
top too small, it would look disproportionate. Likewise, you need to keep in mind what
you’re building for – most things need to be the right size in relation to your avatar, and
since avatars are generally taller than normal humans, furniture for them tends to be
oversized. This is especially true for buildings, since the default camera position is
somewhat behind and above the avatar, requiring higher ceilings and overall bigger
rooms than usual to give the camera room to move in.

Finally, we need to texturize the table, since the default plywood texture doesn’t look
good with most things, you will need to use different ones. Good textures are crucial to
building, and there are some wonderful resources to get them. The best one I found so
far is Filterforge, which is a great application to create your own custom textures, but
even if you don’t buy it, you can still use the sample pictures for the filters off the
website. Filterforge is especially valuable because it can create seamless textures for
almost every filter, and since some textures need to blend into each other or repeat
several times on the surface of a prim, you don’t want seams to show between the
repetitions. In the above example, I used the filter Old Wooden Planks. To apply a
texture, you need to upload it first (file > upload > upload image). It will show up in your
textures folder. Then, select all three prims of your table by holding the shift key and
clicking each of them. (Alternatively, you can hold the shift key and drag a selection
box around all three.) Then switch to the textures tab in the edit window and drag the
plank texture into the Texture field that shows the plywood texture (or click that field
and chose the plank texture in your inventory). You will notice the field will show the
plank texture, but will say “Multiple”. This means, not all surfaces of the prim have been
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updated to the new texture, which is common when you’re re-texturing a lot of
surfaces. Just repeat putting the texture there a few times until it ‘sticks’ and doesn’t
show Multiple any more.
Now the difference between an okay build and a good build is usually the way textures
are handled. The way your table looks now is okay – the top looks good, and the overall
look is coherent. However, upon closer examination, you will see that the sides of the
top and the legs look strange. This is because the textures always cover the whole
surface by default, and since the sides are thinner than the surface, the textures get
condensed there. To get them to look as good as the surface, we need to edit them
individually. To texture a single surface, choose “select faces to texture” in the edit
window and click on the surface you want to texture. You will see a white wheel on that
surface, which means it is selected. If you want to select several textures, you can just
hold the shift key and click on all those you want to texture.
Alternatively, it’s possible to first select the prim you want to re-texture, then switch to
“select faces to texture”, which will automatically select all surfaces, and then de-select
(again with shift-clicking) the ones you don’t want to texture. In either way, please
select the two surfaces on the sides of the table top. You can see that the plank texture
comes with 5 planks, so we will try to cover the sides of the table with exactly one plank.
In the texture tab, you can (among other things) change the repeats per face, and
since we want one plank out of five, change the vertical repeats to 0.2 (which is one
fifth of the texture). This already looks better, but now we’ve got the dark line in the
center of the side, when it should be on the edges, so we will need to move it there. To
do so, change the vertical offset to 0.1, which will move the texture vertically. The
edges of the plank now exactly match the edges of the table. Edit the table legs the
same way. Pay attention to the insides of the legs (the hollow face of the prim), since
this will stretch the texture all the way around its sides, requiring you to raise the
horizontal repeats somewhat (4 repeats would work for our table).((For perfectionists:
remember that your table legs have four little faces where they stand on, too. Even
though usually people will not see those, and thus it’s not neccessary to pay attention
to that, some people pay attention to these details, and it’s the little details that make
a build extraordinary.)) Finally, the ends of the table top need to match the planks on
top, so select the two surfaces on the front and back of the table top and first rotate
the texture by 90 degrees (in the texture tab), then change horizontal repeats to 0.2.
Now the planks look like they properly blend into the sides of the table.
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Finally we should link our table, so we can take it as one object into our inventories. To
do so, select all prims and press ctrl and l, or click the link button in the edit window. The
last selected prim will become the root prim, outlined in yellow, the other prims are child
prims, outlined blue. Usually you chose the one prim that’s closest to the center of the
object and is vertically and horizontally aligned with the overall shape of the object as
root prim. Here, the table top would be the obvious choice. After that you can change
the name of your object in the general tab of the edit window and then right-click it
and take it (or chose “take a copy”, if you want to leave it rezzed.) To backup your
creation, select it and chose File > Export selected objects. This will save it as an .xml file
on your harddisk including all textures neccessary, so it can be re-imported.
Create hair object
(from http://opensim-creations.com)
Hair made out of an assemblage of prims. The reasons for that are that prims allow for a
much wider variety of hairstyles, and the original hair mesh didn’t look very pretty or
natural to begin with.
The beginning of all hair is the torus.
Indeed, many prim hairs either consists entirely of tori, or tori in combination with
sculpties, so you will need to become familiar with that particular type of prim. For a
start, we will transform it into a strand of hair.
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To do that, we change Taper X and Y both to 1.00, which makes the torus pointy on
one end, then cut the path to 0.500 at the beginning, so we end up with a pointy halftorus, which already looks quite like a strand of hair.
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Only that wood texture on it won’t work too well with hair, so we need to do something
about that.
Hair textures you can use for your own creations.
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Now this is about as far as theory can go; the actual process of creating hair is artistic,
and can’t really be taught in a tutorial.
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Finally, it’s time to link the hair. Step off the posing stand and create a sphere in the
center of the hair, in a place which will be inside the skull when the hair is attached. This
will be your root prim, it will make attaching and positioning the hair much easier, since
the initial rotation and position of the hair always depends on the root prim, and after
pretty much all the prims in the hair are already in an “off” position, none of them is
suitable for a root prim. Make a selection square around the hair, deselect and select
the sphere in the center (to make it the last selected prim) and then link the whole set.
After that, take a copy of it and attach it to your skull. Position it, if needed.
Make flexi prims object
(from http://www.mermaiddiaries.com)
Flexible prims, or flexi prims, enable certain types of prims to bend or flex in reaction to
movement or the SL wind. This feature enables designers to create objects with a more
realistic feel. Today, many hairs, clothes, plants, decorations contain a few flexi prims.
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Flexi prims are a client-side effect. That means flexi prims would not cause lag on the
server. So dont feel too bad about using them :) But like anything, if you have too many
complex flexi prims, it could slow down the computer of any resident who could "see"
your flexi prims.
This tutorial will talk about how flexi prims work and the settings that control them. We
are also going to create a set of flexi prim ribbons for wearing around the wrist.

Currently, flexi prims can only be made from Boxes and Cylinders. A flexi prim is a Box or
Cylinder with a checkmark in the Flexible Path box.
You should see a wooden box appear. In the Edit window, if you see the "More >>"
button, go ahead and press it to get the rest of the options. Click on the "Features" tab.
Then click on the Flexible Path checkbox to check it.
Thats it! You just made a flexi prim.
OK, you are probably wondering why nothing is happening. Thats because our box is
not moving and its not set to be sensitive to the SL wind.
So click and hold on the red arrow and drag the cube back-and-forth. You should see
it jiggle like a cube of Jello.
Before we proceed, lets change our box a little so we can see the effects better.
Right-click on the flexi prim box and select "Edit". Make the following changes:
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Go to the "Object" tab and increase the "Size (meters)" setting for "Z" to 3.000.
Change both "Taper" "X" and "Y" to 1.00.
Go to the "Texture" tab. Click on the picture above "Texture". At the the "Pick:Texture"
window, click on the "Blank" button and click "Select".
Click on the picture above "Color". At the "Color Picker" window, click on the dark blue
rectangle on the bottom and click "Select".
Ok, now it should be much easier to see our box flex.
Flexi Prim Settings
In general, there are a few things you should know about flexi prims:







Only Boxes and Cylinders can become flexi prims.
Flexi prims only flex along the Z-direction. The "bottom" of a newly rezzed flexi
prim is the "anchor". The "anchor" doesnt flex. The rest of the flexi prim flexes
around the "anchor". You can always rotate a flexi prim if you need it to flex in a
different direction.
The longer a flexi prim, the more it will flex. Really short flexi-prims dont flex well
(they just kinda jiggle a little).
Flexi prims are phantom objects (you can walk right through them). Also,
anything you link a flexi prim to will also become a phantom object.
You can torture a flexi prim just like any other prim, except Top Shear doesnt
work. So you can use Path Cut, Hollow, Twist, and Taper on a flexi prim.
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So what are all those settings under Flexible Path?
Each setting controls an aspect of how the flexi prim behaves when moved. Lets run
through them and see what they do.
Softness
Have you ever played with a long candy cane (one still in its wrapper)? If you break it in
the middle, you can move the broken end around a little bit. If you break it a couple
more times, the candy cane becomes even more flexible.
Think of a flexi prim as a stick with a number of joints in it. The stick can bend a certain
amount at each joint. So if the stick has more joints, it can bend more.
The Softness setting determines the number of joints that a flexi prim has. It can be either
0, 1, 2, or 3.
A setting of 0 is a really stiff flexi prim with just 1 joint at the anchor location.
A setting of 3 will flex very well, provided that the flexi prim is long enough.
Note that a high Softness setting creates work for your computer (and anyone who can
"see" your flexi prim). If you have more than a couple flexi prims, avoid using a Softness
setting of "3". In general, a Softness setting of "2" works well for most things, from flexi skirts
to flexi hair.
Try changing the Softness setting and moving your flexi prim around to see the effects.
Gravity
Gravity determines how much downward pull there is on the prim. The setting can be
anywhere from -10 to 10.
A Gravity of 10 means a prim thats bends towards the ground. If we rotated our flexi
prim sideways, it would point straight to the ground. It will still respond to movement, but
will try hard to get back to the ground. Perfect for that heavy flexi skirt you dont want to
fly around too much.
On the other hand, a Gravity of -10 gives a strange upward pull to the sky. Sorta weird
anti-gravity. Try it on your flexi hair when you first get up in the morning :P
Drag
Drag is kinda tricky. Drag determines whether a flexi prim will snap into place quickly or
in slow motion. The setting can range from 0 to 10.
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A Drag setting of 0 means there is...well...no drag. So the flexi will whip around freely.
On the other hand, a Drag of 10 makes the flexi action like its in slow motion. Have you
seen those flexi skirts that take forever to fall to the ground? They have a high Drag
setting...
Wind
Wind is a cool setting :) It determines how much the "wind" in Second Life affects the
flexi prim. Yep, theres a wind that constantly blows thru SL. It changes direction all the
time. And the strength of the wind varies as well. And oh BTW, the SL wind goes right
thru walls (so its blowing indoors as well :P).
The Wind setting gives your flexi prim a natural movement. This is great for hair. It's
especially important for stationary flexi prims, like flags or ribbons; otherwise, stationary
flexi prims wont move at all.
The Wind setting can range from 0 to 10.
A setting of 0 means the SL wind has no effects on the flexi prim.
A setting of 10 means the flexi prim will flap wildly to the slightest SL wind. It will also be
very sensitive to direction changes in the SL wind. Great for things like ribbons.
Tension
Tension determines how stiff the flexi prim is. It sorta gives the flexi prim a backbone. The
Tension setting can range from 0 to 10.
A setting of 0 means there is no tension. The flexi prim will be like a piece of string with
very little stiffness. This is what ribbons should be set to.
A setting of 10 means a very stiff flexi prim. It will act almost like a spring, and will try to
maintain its shape.
X, Y, and Z
The X, Y, and Z settings gives a push in the respective direction. The settings can be -10
to 10, so it could be a positive or negative push (or pull, so to speak).
Note that these settings are always relative to the sim. So they have very weird effects
when used on attachments. Um...picture a piece of hair that always wants to point
towards the west :P For the most part, these settings are not very useful for attachments.
The Z setting is almost identical to Gravity (so you might as well use Gravity).
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For stationary flexi prims (like flexi prims on buildings), these might be useful in creating
an effect. For example, you can use the X setting to make a flag point towards the
east, unless theres a very strong wind in another direction.
Attach objects to avatar
When you're finished object creation, click on all prims of object. The last you clicked
this will be Root Prim of object. Click on the "Tools" option from the top menu bar and
select "Link".
Right-click on the Torus and select "Take" to take it into our Inventory.
Right-click on your object in inventorty and select "Attach To >" and "L Forearm".
When you first attach most objects, they usually show up in a funny spot.
Right-click on the object and select "Edit".
Go to the Object tab and enter the needed changes.
Right-click on the object and select "Detach". This will detach the object and "save" the
changes we made. From now on, you can simply "Wear" the object.

Animation Override (AO)
(from http://wiki.secondlife.com)
An animation, is a set of instructions that cause an avatar to engage in a sequence of
motions. You can use animations to make your avatar clap their hands, dance, blow
someone a kiss, and much more.
Check out Martin Garstenauer's thesis for a good introduction to the principles of
character animation. Find out what a quaternion is. See Internal Animation Format for a
description of the animation data format.
Custom animations can be created in programs such as Poser, Blender, and others. In
2005, one resident-made program was released, called Posemaker(ref-thread). And in
2006, two Free ones were released: Avimator (ref-thread) and slat (ref-thread). In-World
tools such as AnyPose (ref-thread) and U-Poser (ref-thread) can also be used to create
animations for Second Life. Animations can be imported from these programs into
Second Life by storing them as Biovision Hierarchy files, which have a file extension of
BVH, and using the main menu File > Upload Animation command. There is a L$10 fee
for uploading an animation. Animations can be previewed prior to uploading.
Animations can be used in gestures in Second Life but should not be confused with
gestures.
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Animations in one's inventory can be activated by double clicking the animation name
in the inventory list, or by right-clicking the animation name and selecting Open from
the context menu. This will produce a dialog box with the animation name, a field in
which to see or enter a description of the animation, and two buttons: Play in World
and Play Locally. Play Locally will cause the user to see the animation but it will not will
be visible to other Residents. This is useful to make sure the animation is really something
you want others to see your avatar doing. Play in World will cause the Residents within
visual range to see your avatar perform the animation.
There are many animations available inworld, both free and for sale. You can get
started locating some by pressing the Search button in the bottom of the SL screen,
selecting the All tab, and entering "animation" as a search term.
Basic Knowlege For Creating SL Animations
The BVH file
The BVH is the text data that describes each figure part's rotation and position along a
timeline.
Hip is the top
Hip is the top of the hierarchy construction of figure in BVH. So, if you want to move the
whole body, you have to move the hip.
Keyframe
Animation is created by keyframe animation. It is an animation technique which builds
the frame that sets up the position and rotation angle of the part called a keyframe. A
computer carries out a complementary automatic calculation and creates the motions
in frames between keyframes. A keyframe is built for every part.
The first frame
You can create a stationary posture just by one frame animation, but note that you
cannot move the whole body and cannot assign multiple priorities. This is convenient
when you want an absolutely stiffened posture. The first frame of the animation that you
created is used as reference information for the root part (hip) between BVH and SL.
The first frame's posture doesn't appear inworld at all, but is recognized as a keyframe.
Inworld animation only occurs after there is a difference from the position of the first
frame and a rotation angle. Therefore, a stationary pose is actually composed to two
separate frames. It is a good idea to set at zero on every parts' rotation and position at
the first frame (a "T" pose) because it makes it easier to keep track of which parts you
moved.
To recap: The first frame of an animation is a reference frame and is not shown in-world;
any deviation from the first frame, however, will be interpreted as an avatar animation.
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Spline interpolation
If the tool has a spline interpolation feature, you may encounter some frustration until
you knew how to control it. Use the cutting spline option which should be implemented
too, such as "Break spline"(link broken).
Inverse Kinematics
If the tool has the inverse kinematics feature and it's turned on, you might find it
frustrating until you knew how to turn it off. Find it and learn how to turn it on/off.
Speed of the animation
The default speed of animation is 30 FPS, that is it takes 1 second to play 30 frames. If
you want 10-second animation, you need to create 300 frames. But you may also be
able to change FPS value on each tool. And note that SL allows you to upload an
animation up to 30 seconds.
Priority
The default built-in animations are always available to your avatar in-world. They may
have different priorities on each keyframed part, unlike uploaded animations which
always have the same animation on the whole body. Unless you give a higher priority to
your animations, your animations will be overriden by them in-world. Priorities range
from 0 to 4, with 4 being the highest priority. See the default built-in animations page to
make sure what kind of priority each animation has.
Priority for uploaded animations is only given for the whole avatar, and is set in the
uploading window. However, unless you animate each individual part of the avatar in
your animation, some parts may be overridden by default animations (breathing,
walking, etc.)
A later playing animation is given priority over the former one when their priorities are
the same.
Optimization
SL's BVH importer does optimization of animation data prior to upload into SL. Joint
rotations with very slight changes from keyframe to keyframe will be interpreted as *not*
changing and thus aren't stored. This is done intentionally since custom animation data
is stored on our servers and downloaded to each viewer as it is needed in real time,
and needs to be fairly terse.
The potential side effect of the optimization is what you have observed; joints with very
subtle movement might have their animation data dropped entirely on upload. The
threshold formula is complex, and involves comparing all three axes of data per joint,
the distance moved between keyframes, as well as the joint's position in the skeletal
hierachy.
Page 77

OpenSimulator - Complete guide for beginners

Scale of the avatars' parts
There is a difference between the scale of the figure's parts on the tool and your
avatars in-world. Even if you adjust the position of parts on the tool, it may show you
incorrectly in-world. You may see the avatar sitting while hovering or sinking under
ground. The hip moves by the absolute value. Meanwhile, your avatar's height depends
on the body shape of the avatar. You cannot help but keep in mind how they are
suitable for the position and go back to the tool. Then you have to tweak them again
while ignoring the shape of figure on the tool.
Facial and Hands morph
Unfortunately, you cannot customize these animations. You can just select the built-in
ones and add them to your animation on the uploading window. You can also evoke
the built-in facial animations by script.
It is said those options are broken for a long time, however.
Uploading window
1. Name: Your animation file's name.
2. Description: You can write something here as a note.
3. Priority: The range is 0-4. 4 is the highest value.
4. Preview while: You can select several internal animations to make sure your
animation while playing.
5. Loop: Click and put the check mark here to get a looping animation. It is not
used when you create a stationary pose.
6. In(%) & Out(%): You can select the range where you want to loop your
animation in the whole timeline. Note, it starts from the first frame first, and then
loops. So when you set 100% in the both fields, you can get an animation that
starts moving and stops with the stationary pose at the last frame.
7. Hand Pose: You can select and add one of the several hand morphs to your
animation here (broken).
8. Expression: You can select and add one of the several facial morphs to your
animation here (broken too).
9. Ease In(sec) & Ease Out(sec): This setting allows you to set the amount of time for
your avatar to realistically ease (or morph or tween) into an animation from it's
current pose, or out from the end of the animation into the next. A setting of
0.000 will cause your avatar to snap instantly into the new pose, instead of
smoothly transitioning there. This setting is measured in seconds.
10. Play & Stop buttons: You can play your animation to make sure before
uploading here.
11. Pose screen: Just click and drag up-down on the screen, the camera moves
zoom in/out. Drag left-right, the camera turns around the figure. Hold Ctrl, Shift or
Alt and drag, and the camera can move in all directions.
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Uploading your animation
1. Select "Uplaod Animation" under the pull-down "File" menu where is the top of
screen in world.
2. Select your BVH file which you created.
3. The upload window opens. You have to set the followings on the window.
1. Priority: "4" (rf. Priority of The Basic Knowledge)
4. Insert the check mark next to "Loop" by clicking. Pose is just the looping
animation of the second frame.
5. "In(%)" & "Out(%)" are from where start and to where end to play your animation
in the whole frame. Now this doesn't matter because you created just one
frame.
6. "Pose Hand" & "Expression" are options. They are hand and face morph.
7. In "Ease In(sec)" & "Ease Out(sec)", you can add time dilation to play and stop
your animation. If you put "1"(sec) in "Ease In(sec)"field, the avatar will take 1 sec
to sit while morphing.
8. Press Play button and make sure how your animation is good. You can select
"Preview while" pull-down menu, such as walking, sitting and so on.
9. Press "Upload(L$10)" button and get your animation.
Anatomy of a simple female walk cycle using Qavimator
(from http:// http://www.jeaniesing.com)
Download Qavimator from here http://qavimator.org and install it.
Start with 62 frames looping at 62 (for now)
Frame 2 - a fully forward extended right leg
Female hips change on the z axis (blue) when walking and swing from side to side on x
pos... male hips ignore both of those and track straight






hip: x rot 0
y rot 14
z rot -7
x pos -1
y pos = 43

Both feet should both be lined up on the midline beneath the avatar (females)






r thigh: x rot -20
y rot -22
z rot 7
r shin: x rot -1
r foot: x rot -1
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l thigh: x rot 30
y rot -11
z rot 11
l shin: x rot -1
l foot: x rot 1

Abdomen and chest compensate for the z rotation (blue) on the hips.. changes here
and in the hip produce a sexier or more conservative walk. The chest swings opposite
the hip to balance. T he center of the top of the head should stay in the same place all
the time and always face forward, use the abdomen, chest, neck, and head to make
that happen.






abdomen y rot -9
z rot 9
chest y rot -15
z rot -4
head y rot -9

Arms and shoulders swing opposite the hip















r collar: x rot 5
y rot -5
r shldr: x rot -18
y rot -20
z rot 82
r forearm x rot -3
r hand z rot -7
l collar x rot -5
y rot -5
l shldr x rot 31
y rot -26
z rot -78
l forearm y rot -13
l hand z rot -11

On frame 2 ... select copy then paste in the frame 2 as well (where there once were no
dots, all dots appear - to mark the ones we missed)
Frame 32: Create a mirror of those starting with the hip...
Use the same number values, BUT notice that to make it look right, sometimes a
negative value will turn into a positive value, one example given - you figure out the
rest.
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hip: x rot 0
y rot 14
z rot -7

Don't forget to change the x pos on the hip to 1 instead of -1
Use the values for the right thigh, in frame 2, to swing the left thigh forward in 32, etc
When finished with frame 32 ... select copy then paste in the frame 32 as well
Frame 62: copy from frame 2 and paste to frame 62 so that you have a loop....
Save and play... NOT a walk yet! But you can see the general swing of body now.
Add the details
Keep the grounded foot level on the ground





frame 5 rfoot x rot 11
frame 26 rfoot x rot -20
frame 36 lfoot x rot 11
frame 37 lfoot x rot -20

Keep the ground foot on the midline





frame 11 rthigh z rot 7
frame 22 rthigh z rot 1
frame 42 lthigh z rot -7
frame 52 lThigh z rot -1

Bend at the knee for a natural stride





frame 9 lShin 24 – note.. this puts the tip of the toe just where it Was In frame 2
frame 23 lshin 11
frame 39 rShin 24 - and this puts the tip of the toe exactly where it Was In frame
32
frame 53 rShin 11

The natural up and down of a walk...



frame 16 hip y pos 44.5
frame 46 hip y pos 44.5

The force of the footfall – the abdomen, chest and neck collapse downward, head
compensates



frame 4 abdomen x rot 1
frame 5 chest x rot 1
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frame 6 neck x rot 5
frame 8 head x rot -9
frame 34 abdomen x rot 1
frame 35 chest x rot 1
frame 36 neck x rot 5
frame 38 head x rot -9

Finish and Upload
Change the FPS (frames per second) to 60
Save as a .avm file
Go to frame 61 ... select copy then paste in the frame 61 as well (where there once
were no dots, all dots appear)
change the number of frames to 61 (remember 2 and 62 are the same)
save as a bvh file by typing “.bvh” after the file name as you save
upload to the game File>UploadAnimation




set priority to 3
check the loop box
set the ease in and out to .8ish

Sound Clips
(from http://www.wiki.secondlife.com)
Functional Spec
Second Life supports in-world sound clips, which can be played to all residents within
range. The maximum time any clip can be is 10 seconds, requiring longer sounds to be
stitched together. There are various LSL functions that can be used to play sound clips,
as well as a built-in system for gestures. Uploading a sound clip costs $10l, and the clip
must be compatible with SL. As the Knowledge Base says, "Valid sounds are any .WAV
file in standard PCM format, 16-bit/44.1kHz/mono or stereo (which will be converted to
mono anyway), less than or exactly 10 seconds in length. (10.000 seconds is fine, but
10.001 will fail to upload; to the degree of one sample makes a difference.) Sounds
cannot be saved as 8-bit, 22.05 kHz, or any other frequency. Sounds in other formats
can be converted in most sound programs. There is currently no support for
compression formats such as MP3."
Right-click the object and select "Edit". Click "More" in the edit window and go to the
"Content" tab. Drag a sound file into the object's inventory (the large empty space
under "Content";).
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Click the button "New Script". Double-click the script file, delete all text and paste this in:
default
{
touch_start(integer total_number)
{
llTriggerSound("soundfile", 1);
}
}

Replace "soundfile" with the name of your audio file (in quotation marks). If the sound
should be continuously looped, replace llTriggerSound with llLoopSound. It will then
never stop playing though, until the command llStopSound(); is used.
Example (sound looping for 30 seconds):
default
{
touch_start(integer total_number)
{
llLoopSound("soundfile", 1);
llSetTimerEvent(30);
}
timer()
{
llStopSound();
llSetTimerEvent(0);
}
}

Btw, you can upload any .wav sound into SL, as long as the file is recorded with 44.100
kHz, 16 bit. Use the audio recorder that comes with Windows to convert a soundfile to
these settings. It can't be too long though, a complete music title won't be possible
(aside from the copyright issues).

Scripting
(from http://www.wiki.secondlife.com)
LSL is the Linden Scripting Language. This is the language all scripts in Second Life are
written in. The structure of LSL is largely based on Java and C, both of which are widely
used programming languages in the real world. A script in Second Life is a set of
instructions that can be placed inside any primitive object in the world, but not inside
an avatar. Avatars, however, can wear scripted objects. LSL scripts are written with a
built-in editor/compiler. LSL is interpreted and executed on the Second Life servers
(sims), not the client (Viewer).
One thing that makes LSL unique is its emphasis on "States" and "Events". A door can be
"open" or "closed" and a light can be "on" or "off". A person can be "awake" or "asleep".
Page 83

OpenSimulator - Complete guide for beginners

Many real life behaviors can be modeled with "states" and the same can be true for LSL
programs. Minimally a script will have one state, the default state.
An event can be thought of as a "Trigger". Events are not user defined in Second Life,
but rather predefined. They are either caused by objects and avatars interacting in the
world, or they are created in a script. Events trigger event handlers (sometimes just
called "events" as well). For example, when an avatar touches an object, a touch_start
message is sent to the object, which causes the touch_start() event handler to begin
executing. So the minimum LSL program must have one state with one event handler in
it. Here is a look at a minimal program written in LSL that can loosely be translated
as...."When I am in the default state, and I am touched, say "Hello, Avatar!" on channel
zero".
Scripts can make an object move, listen, talk, operate as a vehicle or weapon, change
color, size or shape. A script can make an object listen to your words as well as talk
back to you, scripts even let objects talk to each other.
If you have built in Second Life, everything you can define in the edit window can be
defined in a script. All interaction you see between objects or between avatars and
objects is via scripts.
LSL-Editor
(from http://www.lsleditor.org)
LSL-Editor is a standalone LSL (Secondlife) script editor and run-time environment for
Windows and compiles and executes LSL scripts. No SecondLife viewer is needed nor
connection to the SecondLife grid.
The program is updated on regular intervals. When the project emerges, more and
more code can be compiled, debugged, and tested outside SecondLife world.
Current release LSL-Editor 2.40 featuring:











Code highlighting (including Brackets matching)
Code code completion on known keywords and user defined variables
Auto insert events
Argument information on functions (typing)
Tabbed or MDI interface
LSLWiki or SecondLife color scheme
Code editing ( Copy / Cut / Paste / Delete / Undo / Redo / Find / Replace /
Clipboard function)
Block commenting / uncommenting
Tooltip on keywords (LSL-Editor contains a complete LSL guide!)
Complete LSL Wiki in HTML HELP file
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Auto-indent (using tabs or SecondLife indent scheme)
Help, on every keyword, uses www.LSLwiki.NET information
Compiling, Execution and Debugging outside SecondLife world
llDialog input screen
Printing
XML-RPC
Solution Explorer
Plugin support (lslint)
You don't have to install (!) the program, just unzip and use it.

Runs on Windows XP , Windows 2000 , Windows 2003, Windows Vista
.NET Framework 2.0 has to be installed (standard on most Windows machines)
A Basic LSL Tutorial
When you create a New Script from within the Content tab of a prim or from the
context menu of your inventory, the system writes a simple script with the following lines
of LSL code:
default
{
state_entry()
{
llSay(0, "Hello, Avatar!");
}
touch_start(integer total_number)
{
llSay(0, "Touched.");
}
}

This script will basically chat "Hello, Avatar!" on the public channel when it is created
and will then chat "Touched." on the same public channel when an avatar touches the
prim the script is in.
Errors and how to fix them?
If you get an error while scripting at any time, it will usually be that you have missed out
a ; at the end of a function or a { or a } after or before an event. This is the most
common error (a syntax error). Sometimes this may not be the case though.
Basic terms
LSL Functions are shown as red within the Script Editor's composing window.
LSL Events are shown in blue.
TRUE and FALSE are Boolean variables. FALSE is equal to the integer 0 and TRUE is equal
to the integer 1.
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DATA Types
A String is a string of alphanumeric characters surrounded by quotation marks, (eg.
"Hello Bill").
An Integer is a whole number between −2,147,483,648 and +2,147,483,647, which
includes 0.
A Float is a number with a decimal fraction like 1.0 or 1.000000 depending on the
precision you need in your calculations.
A Vector is a set of three floats enclosed in < pointy brackets > like so: <0.0, 0.0, 0.0>.
They can represent colours and positions.
A Key is a randomly generated Universally Unique Identifier (UUID). This specialized string
consists of 32 hex characters with four dashes.
TASK 1
Let's begin by learning an easy task first by making the box say something else when
you touch/click it. You can do this by editing the "llSay(0, "Touched.");" line within the
touch_start event. Just edit the string between the quote marks. The function llSay()'s
format is interpreted as meaning: llSay(Channel number to transmit the text, "string of
text to send");
llSay is not the only communication function within the LSL. You can also try out:
llShout(Channel, "SHOUT STUFF");//can be heard 100m away from originating script
llWhisper(Channel, "WHISPER STUFF");//can be heard 10m distance llOwnerSay("SAY
STUFF TO YOU ONLY"); llRegionSay(Channel, "REGION SAY STUFF");//can be heard within
the entire region
TASK 2
Let's just add some information after this explaining what it each thing does, you can do
this by adding // and anything after it will appear orange, this is a comment. Your script
should look something like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
state_entry()
{
// PUBLIC_CHANNEL has the integer value 0
llSay(PUBLIC_CHANNEL, "Hello, Avatar!");
}
// when someone starts touching the prim
touch_start(integer num_detected)
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{
llSay(PUBLIC_CHANNEL, "Touched.");
}
}

TASK 3
Let's now try make it change its color when we click it, the function we will need is
llSetColor, its layout is like this llSetColor(vector color, integer face); this basically means
if i wanted the cube to be red i would use the vector <1,0,0>, green <0,1,0>, blue
<0,0,1>.
If it was a linked object you could use llSetLinkColor, which its layout is
llSetLinkColor(integer linknumber, vector color, integer face). Your script should look
something like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
state_entry()
{
// PUBLIC_CHANNEL has the integer value 0
llSay(PUBLIC_CHANNEL, "Hello, Avatar!");
}
// when someone starts touching the prim
touch_start(integer num_detected)
{
// color all faces red
llSetColor(<1.0, 0.0, 0.0>, ALL_SIDES);
}
}

TASK 4
Let's now make it have text appear over it, you can do this by using the function
llSetText, its layout is llSetText(string text, vector color, float alpha). Basically if you do this
llSetText("HELLO CAN YOU READ THIS",<1,0,0>,1); will appear as HELLO CAN YOU READ
THIS in the colour red. Alpha is the transparency, if you did llSetText("HELLO CAN YOU
READ THIS",<1,0,0>,0); you wouldn't be able to see it. 0 = high transparency, 0.5 = in the
middle, 1 = no transparency. Your script should look something like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
state_entry()
{
// PUBLIC_CHANNEL has the integer value 0
llSay(PUBLIC_CHANNEL, "Hello, Avatar!");
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}
// when someone starts touching the prim
touch_start(integer num_detected)
{
// green and opaque floattext
llSetText("Nice to meet you!", <0.0, 1.0, 0.0>, 1.0);
}
}

TASK 5
Now that you understand alpha we shall make our object disappear! To do this we will
use the function llSetAlpha, its layout is llSetAlpha(float alpha, integer face).
llSetAlpha(0, ALL_SIDES); would make all the faces of the object transparent. If it was a
linked object you could use llSetLinkAlpha, which its layout is llSetLinkAlpha(integer
linknumber, float alpha, integer face). Your script should look something like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
state_entry()
{
// PUBLIC_CHANNEL has the integer value 0
llSay(PUBLIC_CHANNEL, "Hello, Avatar!");
}
// when someone starts touching the prim
touch_start(integer num_detected)
{
// set all faces to transparent
llSetAlpha(0.0, ALL_SIDES);
}
}

Task 6
Let's try make our object texture itself, to do this we will use the function llSetTexture, its
layout is llSetTexture(string texture, integer face).You can do this two ways, you can
place a texture inside the object or use a UUID. To make it change to a texture you
have placed inside the object, do it like this llSetTexture("NAME OF TEXTURE", ALL_SIDES);
If you want to use a UUID, find a texture in your inventory, right click it > copy asset UUID,
then paste the UUID in the "" so it looks like this llSetTexture("j4m3s000-0000-0000-0000b3n3d3k00000", ALL_SIDES); If it was a linked object you could use llSetLinkTexture, which
its layout is llSetLinkTexture(integer linknumber, string texture, integer face); Your script
should look something like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
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state_entry()
{
// PUBLIC_CHANNEL has the integer value 0
llSay(PUBLIC_CHANNEL, "Hello, Avatar!");
}
// when someone starts touching the prim
touch_start(integer num_detected)
{
// apply texture within contents of the same prim
llSetTexture("name of texture", ALL_SIDES);
}
}

Task 7
Now let's move onto something more tricky, as you understand a bit about keys we will
make out object only respond when the owner clicks the object, this is called a if
statement. To do this we will need to use the functions llGetOwner() and
llDetectedKey(0);, llGetOwner will return your key UUID and llDetectedKey(0) when put
under the touch event will return the key of who is clicking/touching your object. So
firstly lay it out your script like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
state_entry()
{
// PUBLIC_CHANNEL has the integer value 0
llSay(PUBLIC_CHANNEL, "Hello, Avatar!");
}
// when someone starts touching the prim
touch_start(integer num_detected)
{
key owner = llGetOwner();
key touchingAvatar = llDetectedKey(0);
if (owner == touchingAvatar)
llSay(PUBLIC_CHANNEL, "Touched by owner.");
}
}

If you want it to do something when someone else other than the owner touches it, use
a else statement. You can do this by, laying out your script like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
state_entry()
{
// PUBLIC_CHANNEL has the integer value 0
llSay(PUBLIC_CHANNEL, "Hello, Avatar!");
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}
// when someone starts touching the prim
touch_start(integer num_detected)
{
key owner = llGetOwner();
key touchingAvatar = llDetectedKey(0);
if (owner == touchingAvatar)
llSay(PUBLIC_CHANNEL, "Touched by owner.");
else
llSay(PUBLIC_CHANNEL, "Touched by someone else.");
}
}

Task 8
Now let's try make a object do something when you say something, to do this we will
have to use a llListen function, its layout is this llListen(integer channel, string name, key
id, string msg); We will firstly place this under the state_entry() event. In this task we will
just make it use the public channel, which is 0, and we will make it listen to only you,
which requires the llGetOwner() function we used previously. We will then need to use a
listen event, its layout is like this listen(integer channel, string name, key id, string
message) {, replace the touch event with this. we will then make the object annoy you
by it saying "Really?" whenever you type something XD This will involve using a llSay like
we used in task 1. Your script should look something like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
state_entry()
{
key owner = llGetOwner();
// PUBLIC_CHANNEL has the integer value 0
llListen(PUBLIC_CHANNEL, "", owner, "");
}
// when something has been heared
listen(integer channel, string name, key id, string message)
{
llSay(PUBLIC_CHANNEL, "Received: '" + message + "'.");
}
}

To make it only listen for commands not on the public channel, which will be more
secret and which is less laggy in complex scripts, you can do this by changing the
integer 0 to something like 99, this time use a llOwnerSay instead of a llSay, which should
make it secret. Your script should look something like this:
default
{
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state_entry()
{
llListen(99,"",llGetOwner(),"");
}
listen(integer channel, string name, key id, string message)
{
llOwnerSay("Really?");
}
}

To chat in another channel, just type in the chat bar /channel before you type
something, in this case it will be "/99 hello" for example.To make it do only certain stuff
when you say certain commands we will have to use a if statement, like before but this
time we will have to check if the message equals the command, if (message == "Your
Command Here"). Your script should look something like this:
default
{
state_entry()
{
llListen(99,"",llGetOwner(),"");
}
listen(integer channel, string name, key id, string message)
{
if (message == "hello")
{
llOwnerSay("Hello to you too!");
}
else
{
llOwnerSay("INVALID COMMAND");
}
}
}

TASK 9
Now let's experiment with vectors, and make your object move non physically, to do
this we will need to use the function llSetPos, its layout is llSetPos(vector pos); We will also
use llGetPos() so we can make it move +1 of its current position. Place the llSetPos
function under a touch event with a vector <0,0,1> + llGetPos();. Your script should look
something like this:
default
{
// when the script has been saved (only in default) or when re-entering this
state
state_entry()
{
// PUBLIC_CHANNEL has the integer value 0
llSay(PUBLIC_CHANNEL, "Hello, Avatar!");
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}
// when someone starts touching the prim
touch_start(integer num_detected)
{
vector oldPosition = llGetPos();
llSetPos(oldPosition + <0.0, 0.0, 1.0>);
}
}

A position vector layout is in the format x,y,z, so <0,0,1> will make it go up 1m.
TASK 10
Like when editing a object you can make it Phantom, Physical... You can also do this
with scripting, the function you have to use to do this is llSetStatus, its layout is
llSetStatus(integer status, integer value);, so if i wanted to make my object go physical
the integer status would be STATUS_PHYSICS or 1, if i wanted to make my object go
phantom i would use STATUS_PHANTOM or 16. Your script should look something like this:
default
{
state_entry()
{
llSetStatus(STATUS_PHYSICS, TRUE);
}
}

You now know pretty much the basics of scripting, but there are still many more
functions to use and experiment with yet!
Running Your First Script
Traditionally one starts by writing the smallest program possible to print "Hello, Avatar!".
Since LSL only runs inside objects, you must know how to create an object and put a
script inside it.
You must be on land which allows building. Either your own land, or land where you
have permission to build, such as a sandbox. Right click on the ground and choose
Build.
By default, you should see a wand icon with which you can click and create a cube on
the ground.
You will automatically enter Edit mode and an Edit window will pop up. To place a
script in an existing object, right click the object and click Edit to open the edit window.
In the edit window you may see a button marked More>> click it to reveal five tabs
marked General, Object, Features, Texture, and Content. Click Content.
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This window shows the contents of an object which can hold scripts, notecards,
textures, sounds, even other objects. Press New Script to add a new script.
This will open the LSL editor with a default script. This editor will color code your syntax
and provide some info about keywords when you hold your mouse over them. It will
also do basic syntax checking.
Before explaining the code, lets run it. Hit Save and close your Edit window (not the LSL
editor window).
You should see the words "Hello, Avatar!" from "Object"
If you touch the object, it will say "Touched." The "Edit" window must be closed for
touching to work.
Congratulations! You have compiled and run your first LSL script!
Development Cycle (Wash / Rinse / Repeat)
We now have a running script, however most scripts you make will not run the first time
you run them. It will take many tries as you correct errors and make improvements.
When you hit "Save" on a script, the LSL editor "compiles" the code to something LSL can
understand. It will stop however if it finds an error.
Brackets, parentheses, and semicolons must all be perfectly in place before a script will
run. If you are new to programing this can be one of the most infuriating steps and lead
you to screaming DWIM (Do what I mean!) Part of becoming a programmer in ANY
language is learning how to precisely define steps and correctly type them into the
language you are working in. Thus you will find yourself writing, running, then RE-writing
your code several times.
The script you made runs the instant you hit save. If you take it into inventory, it will
"suspend" what it was doing but go right back to it when rezzed (resurrected) again. (If
you are not familiar with "taking" and "rezzing" an object you may need to revisit your
building skills).
Each time you re-write your code, reset the script. Try resetting the script inside a prim in
the following ways:





Press Reset in the script window.
Select the object and choose BUILD > SCRIPTS > RESET SCRIPTS (for older viewers
TOOLS>RESET SCRIPTS IN SELECTION)
By checking and unchecking the "Running" check-box
Choose BUILD > SCRIPTS > SET SCRIPTS TO NOT RUNNING (for older viewers
TOOLS>SET SCRIPTS TO NOT RUNNING IN SELECTION) and then BUILD > SCRIPTS >
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SET SCRIPTS TO RUNNING (for older viewers TOOLS>SET SCRIPTS TO RUNNING IN
SELECTION).
Once you get comfortable with stopping, starting, and resetting a script, try changing
the words "Hello, Avatar!" and see what else you can make it say.... for goodness sakes
keep it PG.
Dissecting "Hello, Avatar!"
Lets take a look at the default code.
default
{
state_entry()
{
llSay(0, "Hello, Avatar!");
}
touch_start(integer total_number)
{
llSay(0, "Touched: "+(string)total_number);
}
}

The code above contains 1 state, 2 events and 2 functions. Lets look at them
individually.
Any line starting with two forward slashes is a comment. It will not run and is used to help
you document your code.
// This is a comment

STATES
A "State" in LSL is a section that is running, and waiting for events. Only one state can be
active at any one time per script. Every script must have a default state with at least
one event in it. Except for the default state, each state is defined by the word STATE
followed by the name of the state. The contents of the state are enclosed in two curly
brackets.
default
{
// contents of state go here
}
state playing
{
// this is a state called "playing"
}
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EVENTS
Events are inside of states. By "inside" I mean it is between the open and closed curly
brackets that represent the body of the state. When that state is active, those events
wait to be triggered and run the code inside them. We have seen "state_entry" which is
triggered by the state being entered, and "touch_start" which is triggered when you, or
anyone, touches an object.
Lets take a look at the default code.
// Code start
default
{
touch_start(integer total_number) // this is an event
{
// this is the content of the event (between curly brackets)
}
}
// end of default state

FUNCTIONS
Functions lay inside of events and are either defined by you or built-in. Those built in to
LSL all start with two lowercase L's. We have seen llSay() so far. Functions take
"arguments" or values in the parentheses that follow it. If you hover over the function in
the editor, a pop-up will show that tells you what the function is expecting. In the case
of llSay it expects a number and a string. We send it the number zero and the string
"Hello, Avatar!" separated by a comma. The function is "expecting" a number and
strings and will not take anything else.
Line by line, here is the hello avatar script.
default // All Scripts need a Default State
{ // this open curly bracket denotes the start of the state
state_entry() // an event
{
llSay(0, "Hello, Avatar!"); // a function inside the event's
// curly brackets
} // closed curly bracket closes the state_entry event
touch_start(integer total_number) // another event inside default state
{
llSay(0, "Touched."); // a function between the brackets
// of the touch_start body
} // end of touch start
} // Code end

The instant you save your script, it enters default state, which in turn runs the
"state_entry" event which in turn runs the function llSay() which makes the object talk.
Page 95

OpenSimulator - Complete guide for beginners

After this, the program waits idle in the default state until a new event is called.
Touching the box triggers the event "touch_start" which also makes the object speak.
Introducing States and Events
LSL scripts will not run beginning to end. Instead, they will look for a default state and
wait for an event. Within those events, there can be a call to go to a new state.
All programs must contain the default state, inside of which must be at least one event.
Events are triggered either by actions happening to or around the object the script
resides in, or are triggered from the script itself.
On/Off Example Using States
Let us look at a script with two states with two events in each.
default //default state is mandatory
{
state_entry() // runs each time the state is entered
{
llSay(0, "turning on!"); //object speaks!
llSetColor(<1.0, 1.0, 1.0>, ALL_SIDES); // sets all sides
// to most bright
// note the semicolons at the end of each instruction
// (do not put them at the end of "if" statements)
}
touch_start(integer total_number) // another event with only
// one function inside
{
state off; // sets the script to a new "state"
// and starts running "state off"
}
} // this curly bracket ends the body of the default state.
state off // a second state besides "default"
{
state_entry() // this is run as soon as the state is entered
{
llSay(0, "turning off!");
llSetColor(<0.0, 0.0, 0.0>, ALL_SIDES); // sets all sides
// as dark as possible
}
touch_start(integer total_number)
{
state default;
}
}

A simplification of this would be
default
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{
//set color to light and, if touched, enter the "off" state.
}
state off
{
//set color to dark and, if touched, enter the "default" state.
}

Note that after "default" all new states begin with the word "state". Also, while the object
has a texture, the color will affect the "tint" more than the true color.
Default State
Let us examine the default state.
First we see the "state_entry" event, which gets triggered each time the default state is
entered. Which in this case is entered the first time the script is run.
SPEAK TO ME!
The first line in the event state_entry is...
llSay(0, "turning on!");

This makes the object speak "turning on!" on channel zero. What is channel zero? It is
the same channel you see all public chat on.
A semicolon ends the line and yet another instruction follows.
llSetColor(<1.0, 1.0, 1.0>, ALL_SIDES);

This turns the prim to its brightest tint. If you take the texture off the prim, you would see it
as bright white but with a texture, it looks "normal." The three ones stand for the Red,
Green, and Blue values of the tint.
At this point the event is finished with the two lines of commands. Then the script waits
idle in the default state for more events to happen.
TOUCHED BY AN AVATAR
While idle in the default state a touch will trigger the "touch_start" event.
Inside of the "touch_start" event is only one command:
state off;

This is a command to move immediately to a new state named "off".
This state is defined after the default state and nearly mirrors the default state, except
that it turns the prim dark and, when touched, will put the script back into default
mode, thus creating a loop.
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Enters default state
Runs code in "state entry"
Waits to be touched
When touched enters "state off"
Enters "state off"
Runs code in "state entry" (note in the "off" state's body)
Waits to be touched
When touched enters "default" state

Then the whole thing starts over.
A Final Word on Words
Making your object speak is a great way to know what a script is doing, but everyone
can hear it for 20m all around you. As you get into more complex scripts this can get
pretty noisy! Three alternative ways to see what is going on exist.
SHHHH WHISPER
llWhisper( ) is just like llSay( ) but only broadcasts at half the distance (10m). You still must
state what channel. So...
llWhisper(0,"turning on!");

...might work a bit to save the sanity of your neighbors.
Using llShout( ) increases the distance heard to a radius of 100m, but can cut the
amount of friends you have in half.
llOwnerSay( ) uses no channel, and is seen in chat only by the object's owner. Very
useful and can triple the amount of friends you have!
llOwnerSay("turning on!");

THE SOUND OF SILENCE
You can make a totally silent message via llSetText( ) like this.
llSetText("I am on", <1.0, 1.0, 1.0>,1.0);

What do the numbers mean? The <1.0, 1.0, 1.0> we have seen before. It represents the
values for red, green, and blue. For now just know that <1.0, 1.0, 1.0> means "white" and
<0.0, 0.0, 0.0> means "black".
Replace the
llSay(0,"turning off!");

with...
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llSetText("I am off", <0.0, 0.0, 0.0>,1.0);

The 1.0 is the alpha setting. 1.0 means fully opaque, and 0.0 would be completely
transparent (invisible).
Rotating Door
Most doors in SL use the same method for opening. They set the door's rotation in one or
more steps, resulting in a somewhat choppy motion. This script uses a mixture of
llTargetOmega() and llSetLocalRot() to achieve a very smooth, pleasant looking
animation for the door. In laggy environments it might be that the script displays a
somewhat flaky behavior, but for most cases it will work nicely.
For those unfamiliar with the typical swinging door, you use a box and do a path cut
0.375 / 0.875 to remove one-half of the prim. This will make appear as if it is swinging on
its edge and not around it's middle.
//
//
//
//
//
//
//
//

Smooth Door Script - Version 1.2
by Toy Wylie
Distributed under the following licence:
- You can use it in your own works
- You can sell it with your work
- This script must remain full permissions
- This header notice must remain intact
- You may modify this script as needed

float openingTime=3.0;
// in seconds
float openingAngle=90.0; // in degrees
float autocloseTime=15.0;
// in seconds
integer steps=4;
// number of internal rotation steps
integer world=TRUE;
// align to world or root prim rotation
string soundOpen="door_open";
string soundClose="door_close";
float omega=0.0;
vector axis;
rotation closedRot;
rotation openRot;
integer swinging;
integer open;
sound(string name)
{
if(llGetInventoryType(name)==INVENTORY_SOUND)
llTriggerSound(name,1.0);
}
openDoor(integer yes)
{
if(yes)
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sound(soundOpen);
vector useAxis=axis;
open=yes;
if(!yes)
useAxis=-axis;
llSetTimerEvent(openingTime/(float) steps);
llTargetOmega(useAxis,omega,1.0);
}
go()
{
if(swinging==0)
{
if(!open)
{
axis=<0.0,0.0,1.0>/llGetRootRotation();
closedRot=llGetLocalRot();
if(world)
openRot=llGetRot()*llEuler2Rot(<0.0,0.0,openingAngle>*DEG_TO_RAD)/llGetRootRo
tation();
else
openRot=closedRot*llEuler2Rot(<0.0,0.0,openingAngle>*DEG_TO_RAD);
}
swinging=steps;
openDoor(!open);
}
}
rotation slerp(rotation source,rotation target,float amount)
{
return
llAxisAngle2Rot(llRot2Axis(target/=source),amount*llRot2Angle(target))*source
;
}
default
{
state_entry()
{
swinging=0;
open=FALSE;
omega=TWO_PI/360*openingAngle/openingTime;
llTargetOmega(ZERO_VECTOR,1.0,1.0);
}
touch_start(integer dummy)
{
go();
}
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collision_start(integer dummy)
{
go();
}
timer()
{
if(swinging>0)
{
swinging--;
if(swinging!=0)
{
float amount=(float) swinging/(float) steps;
if(open)
amount=1.0-amount;
llSetLinkPrimitiveParamsFast(LINK_THIS,[PRIM_ROT_LOCAL,slerp(closedRot,openRo
t,amount)]);
return;
}
llTargetOmega(axis,0.0,0.0);
if(open)
{
llSetLinkPrimitiveParamsFast(LINK_THIS,[PRIM_ROT_LOCAL,openRot]);
llSetTimerEvent(autocloseTime);
}
else
{
llSetLinkPrimitiveParamsFast(LINK_THIS,[PRIM_ROT_LOCAL,closedRot]);
sound(soundClose);
llSetTimerEvent(0.0);
}
}
else // autoclose time reached
{
llSetTimerEvent(0.0);
openDoor(!open);
swinging=steps;
}
}
}

Creating a HUD
HUD is an acronym of Head-Up Display, and allows creators in Second Life to add a
user-interface to gadgets.
They are created from prims just like any other user-created objects in Second Life, but
they are only visible to their owner, and always appear ‘flat’ against the screen. If
you’ve used any gadgets in Second Life, you will almost certainly have come across
them.
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The first thing to do, of course, is to decide what our HUD will contain. Because of the
limitations of SL, it is not easy to include any kind of output in the HUD, so our HUD will
basically be restricted to having some buttons to push.
We are going to create a HUD which allows the user to scan the area for other avatars,
and to ‘poke’ (via chat) one of those avatars. Not very exciting, but it is only an
example.
We will need two buttons: Scan and Poke. We will also need some sort of ‘window’ for
them to sit on. We could have them just floating on the screen, but that would look
rather odd.
The first step is to create a sort of ‘rough draft’ of our HUD. I’ll explain why in a minute.
Let’s start with the window.
X scale to 0.01, so that you end up with a thin, flat board. Move it to somewhere close
so that you can see it easily. If you want, you can blank the texture, though that isn’t
important – we’ll deal with the texture later.
Next, let’s add a couple of buttons. Create two more cubes, setting the X scale to 0.1
again, and setting the Y and Z scale to something that approximates a sort of
rectangular button shape. Place them flat against the ‘window’ board. Don’t worry
about positioning them exactly yet, but you might want to colour them so that you can
see them more clearly.
Link the buttons and the window (I’d suggest making the window the root prim, by
selecting it last before linking, though it isn’t important for the simple HUD that we are
going to make). One warning – don’t rotate this object, otherwise when you come to
attach it, it might not be facing you!
Ok, now we have a primitive-looking window and buttons. Time to turn them into an
actual HUD. Right-click the linked object, click ‘More’ on the pie menu, then click
Attach HUD, and select Center.
If by chance you find that it is at the wrong angle (probably sideways!), you can rotate
it even though it is attached. You might find it easier to adjust the numbers manually in
the build dialog, rather than trying to use the Rotate tool.
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You now have a grotesque HUD, probably occupying far too much of the screen, and
obscuring your view. Don’t worry, there are things we can do about it. In fact, if you are
at all familiar with building stuff, I’m sure that you are already ahead of me. Hold fire,
though, because there are a few things you need to know before going on.
Firstly, yes, you can edit the HUD when it is attached. This is very convenient, because
an unattached HUD is very small and fiddly to work with. However, there are some
limitations on what you can actually edit once the HUD is attached. This is why it is useful
to do a ‘rough draft’ while the HUD is unattached and you have all the editing facilities
available to you.
The most important limitation on editing an attached HUD is that you cannot unlink the
prims that make up the HUD, and you cannot link new prims to the HUD. If you find that
you need to add a new prim, you will have to detach the HUD (it will vanish into your
inventory, and you will need to re-rez it, which is rather annoying), create and link the
new prim, then re-attach the HUD.
To work on the individual elements of the HUD, you need to tick the ‘Edit linked parts’
checkbox on the Build dialog. I’ve found that this normally lets you do most things to the
individual parts, although rescaling prims sometimes refuses to ‘take’. If you get that
happening to you, unfortunately all you can do is drop the HUD and unlink it while you
edit the offending prim.
For our simple example, rescale the entire HUD to something more suitable. You can
then edit the two buttons to position them more exactly (this is much easier to do now
that the HUD is attached).
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Of course, it is still obscuring our view. For now, select the ‘window’ prim, blank the
texture, colour it grey (or whatever you prefer), and set the transparency to something
between 50 and 75.
You could do something similar with the buttons, but we need to get text onto these in
some way. Because SL doesn’t yet provide text-on-a-prim, you will have to break out
your favourite graphics program, and create some button textures.
Naturally, you can do something similar with the texture for your window prim, and
create something fancier than the plain version that we’ve just made.
Here is the final result (I’ve done some resizing, and reattached the HUD at the top-left
instead of the centre):

One final ‘gotcha’. Go back to when we originally attached the HUD, and we found
that it took up large amounts of screen space. How much screen space do you
imagine a prim of a given size will take up? The answer is…it depends. Most crucially, it
depends on the size of the window (or the screen resolution if running full-screen) that
Second Life is using. A HUD will occupy more space in a smaller window, less space in a
larger window. You need to think about this when designing your hud (make the
mistake of trying to create a ‘full-screen’ HUD, and it will only fit properly at one specific
screen-size. Not good).
Ok, we now have our HUD designed and built…but it doesn’t actually do anything!
Time to rectify that.
Page 104

OpenSimulator - Complete guide for beginners

Select the buttons individually, and create a new script in each one.
For the Scan button, edit the script, and replace the default with the following, which
does a simple scan of the surround area, and outputs the names of any avatars found
(the output is done via llOwnerSay, so it is only visible to the user of the HUD):
default
{
touch_start(integer total_number)
{
llOwnerSay("Scanning...");
// Look for any avatars within 96m.
llSensor("", NULL_KEY, AGENT, 96.0, PI);
}
sensor(integer num_detected)
{
integer i;
while(i < num_detected)
{
if (llDetectedKey(i) != llGetOwner())
{
llOwnerSay(llDetectedName(i));
}
++i;
}
}
}

For the Poke button, replace the default script with this rather more elaborate one. This
again does a scan of avatars in the vicinity, and then displays a dialog with their names
as the buttons. When you select an avatar from the dialog, the chat message ‘[Your
name] pokes [avatar name]‘ is displayed.
integer dlgHandle = -1;
integer dlgChannel = -9999;
list avatarList = [];
reset()
{
llSetTimerEvent(0.0);
llListenRemove(dlgHandle);
dlgHandle = -1;
}
default
{
touch_start(integer total_number)
{
llOwnerSay("Scanning...");
avatarList = [];
// Look for any avatars within 10m.
llSensor("", NULL_KEY, AGENT, 96.0, PI);
}
sensor(integer num_detected)
{
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integer i;
while((i < num_detected) && (i < 9))
{
if (llDetectedKey(i) != llGetOwner())
{
avatarList += [llDetectedName(i)];
}
++i;
}
if (llGetListLength(avatarList) > 0)
{
state dialog;
}
}
}
state dialog
{
state_entry()
{
// Set up a listener to detect button clicks.
dlgHandle = llListen(dlgChannel, "", llGetOwner(), "");
// Start a new timer.
llSetTimerEvent(30.0);
// Add a 'Cancel' button.
avatarList += ["Cancel"];
// Display the dialog.
llDialog(llGetOwner(), "Please select an avatar.", avatarList, dlgChannel);
}
listen(integer channel, string name, key id, string message)
{
// The message parameter holds the caption of the
// button that was clicked. Search the menu options
// list for it.
if ((channel == dlgChannel) && (llListFindList(avatarList, [message]) != 1))
{
if (message != "Cancel")
{
llSay(0, llKey2Name(llGetOwner()) + " pokes " + message);
}
reset();
state default;
}
}
timer()
{
reset();
state default;
}
}
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Close the Build dialog, and your HUD should be fully active. Click on the buttons to
check that they work.
Congratulations, you’ve just built your first HUD!
Change object color
// Change the object's color When an avatar is nearby
// Only one time for each avatar
list recent_avatars;
add_avatar(string name) {
if(!seen(name)) {
recent_avatars += name;
if (llGetListLength(recent_avatars) > 25) {
recent_avatars = llDeleteSubList(recent_avatars,0,0);
}
}
}
integer seen(string name) {
if(llListFindList(recent_avatars,[name]) > -1) { return TRUE; }
return FALSE;
}
default
{
state_entry() {
llSensorRepeat("", NULL_KEY, AGENT, 5, PI, 5);
}
sensor(integer total_number) {
if(!seen(llDetectedName(0))) {
// change color!
llSetColor(<1.0,0,0>,ALL_SIDES);
add_avatar(llDetectedName(0));
}
}
}

Change texture object
// Change the object's texture
// When an avatar is nearby
default
{
state_entry() {
llSensorRepeat("", NULL_KEY, AGENT, 5, PI, 5);
}
sensor(integer total_number) {
// set the texture
llSetTexture("texture.jpg",ALL_SIDES);
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}
}

Say something in chat
// Say something in chat
// When someone says something
default
{
state_entry() {
llListen(0,"", NULL_KEY, "");
}
listen(integer channel, string name, key id, string message) {
if (message == "Hi") {
// speak out loud!
llSay(0,"Hi");
}
}
}

Move around
key id;
setup() {
llSetStatus(STATUS_ROTATE_X | STATUS_ROTATE_Y, FALSE);
llSetStatus(STATUS_PHYSICS, TRUE);
llSleep(0.1);
llMoveToTarget(llGetPos(),0.1);
id = llGetOwner();
}
default
{
state_entry() {
}
}

Create hovering text on a repeating timer
default
{
state_entry() {
llSetTimerEvent(15);
}
timer() {
llSetText("I'm here!", <1.0,1.0,1.0>, 1.0);
}
}

Give landmark to an avatar when an avatar touches your object
default
{
touch_start(integer total_number) {
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// This line will pick out the first thing of the right type and give
it to whomever triggered the event
llGiveInventory(llDetectedKey(0),llGetInventoryName(INVENTORY_LANDMARK,0)
);
}
}

Smoke particle
string CONTROLLER_ID = "A"; // See comments at end regarding CONTROLLERS.
integer AUTO_START = TRUE;
// Optionally FALSE only if using CONTROLLERS.
list particle_parameters=[]; // stores your custom particle effect, defined
below.
list target_parameters=[]; // remembers targets found using TARGET TEMPLATE
scripts.
default {
state_entry() {
particle_parameters = [ // start of particle settings
// Texture Parameters:
PSYS_SRC_TEXTURE, llGetInventoryName(INVENTORY_TEXTURE, 0),
PSYS_PART_START_SCALE, <0.2, .2, 0>, PSYS_PART_END_SCALE, <4,4,
0>,
PSYS_PART_START_COLOR, <.5,.5,.5>, PSYS_PART_END_COLOR,
<.1,.1,.1>,
PSYS_PART_START_ALPHA, (float) 0.8,
PSYS_PART_END_ALPHA,
(float)0.0,
// Production Parameters:
PSYS_SRC_BURST_PART_COUNT, (integer)1,
PSYS_SRC_BURST_RATE, (float) 0.1,
PSYS_PART_MAX_AGE, (float)3.0,
PSYS_SRC_MAX_AGE, (float)0.0,
// Placement Parameters:
PSYS_SRC_PATTERN, (integer)8, // 1=DROP, 2=EXPLODE, 4=ANGLE,
8=ANGLE_CONE,
// Placement Parameters (for any non-DROP pattern):
PSYS_SRC_BURST_SPEED_MIN, (float)0.01,
PSYS_SRC_BURST_SPEED_MAX, (float)0.2,
// PSYS_SRC_BURST_RADIUS, 0.0,
// Placement Parameters (only for ANGLE & CONE patterns):
PSYS_SRC_ANGLE_BEGIN, (float)0.05*PI,
PSYS_SRC_ANGLE_END,
(float)0.0*PI,
// PSYS_SRC_OMEGA, <0,0,0>,
// After-Effect & Influence Parameters:
PSYS_SRC_ACCEL, <0.0,0.0,.2>,
// PSYS_SRC_TARGET_KEY,
llGetLinkKey(llGetLinkNumber() + 1),
PSYS_PART_FLAGS, (integer)( 0
// Texture Options:
| PSYS_PART_INTERP_COLOR_MASK
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| PSYS_PART_INTERP_SCALE_MASK
| PSYS_PART_EMISSIVE_MASK
| PSYS_PART_FOLLOW_VELOCITY_MASK
// After-effect & Influence Options:
| PSYS_PART_WIND_MASK
| PSYS_PART_BOUNCE_MASK
// | PSYS_PART_FOLLOW_SRC_MASK
// | PSYS_PART_TARGET_POS_MASK
// | PSYS_PART_TARGET_LINEAR_MASK
)
//end of particle settings
];
if ( AUTO_START ) llParticleSystem( particle_parameters );
}
link_message( integer sibling, integer num, string mesg, key target_key )
{
if ( mesg != CONTROLLER_ID ) { // this message isn't for me.

Bail

out.
return;
} else if ( num == 0 ) { // Message says to turn particles OFF:
llParticleSystem( [ ] );
} else if ( num == 1 ) { // Message says to turn particles ON:
llParticleSystem( particle_parameters + target_parameters );
} else if ( num == 2 ) { // Turn on, and remember and use the key
sent us as a target:
target_parameters = [ PSYS_SRC_TARGET_KEY, target_key ];
llParticleSystem( particle_parameters + target_parameters );
} else { // bad instruction number
// do nothing.
}
}
}

Fire particle
string CONTROLLER_ID = "A"; // See comments at end regarding CONTROLLERS.
integer AUTO_START = TRUE;
// Optionally FALSE only if using CONTROLLERS.
list particle_parameters=[]; // stores your custom particle effect, defined
below.
list target_parameters=[]; // remembers targets found using TARGET TEMPLATE
scripts.
default {
state_entry() {
particle_parameters = [ // start of particle settings
// Texture Parameters:
PSYS_SRC_TEXTURE, llGetInventoryName(INVENTORY_TEXTURE, 0),
PSYS_PART_START_SCALE, <.25,.25,FALSE>, PSYS_PART_END_SCALE,
<.5,.5, FALSE>,
PSYS_PART_START_COLOR, <1,1,0>, PSYS_PART_END_COLOR, <.4,0,0>,
PSYS_PART_START_ALPHA, (float).8,
PSYS_PART_END_ALPHA,
(float).0,
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// Production Parameters:
PSYS_SRC_BURST_PART_COUNT, (integer)4,
PSYS_SRC_BURST_RATE, (float) 0.05,
PSYS_PART_MAX_AGE, (float).75,
PSYS_SRC_MAX_AGE,(float) 0.0,
// Placement Parameters:
PSYS_SRC_PATTERN, (integer)2, // 1=DROP, 2=EXPLODE, 4=ANGLE,
8=ANGLE_CONE,
// Placement Parameters (for any non-DROP pattern):
PSYS_SRC_BURST_SPEED_MIN, (float).1,
PSYS_SRC_BURST_SPEED_MAX,
(float).3,
// PSYS_SRC_BURST_RADIUS, 0.0,
// Placement Parameters (only for ANGLE & CONE patterns):
PSYS_SRC_ANGLE_BEGIN, (float) .03*PI, PSYS_SRC_ANGLE_END,
(float)0.00*PI,
// PSYS_SRC_OMEGA, <0,0,0>,
// After-Effect & Influence Parameters:
PSYS_SRC_ACCEL, <0.0,0.0,1.5>,
// PSYS_SRC_TARGET_KEY,
llGetLinkKey(llGetLinkNumber() + 1),
PSYS_PART_FLAGS, (integer)( 0
// Texture Options:
| PSYS_PART_INTERP_COLOR_MASK
| PSYS_PART_INTERP_SCALE_MASK
| PSYS_PART_EMISSIVE_MASK
| PSYS_PART_FOLLOW_VELOCITY_MASK
// After-effect & Influence Options:
| PSYS_PART_WIND_MASK
| PSYS_PART_BOUNCE_MASK
// | PSYS_PART_FOLLOW_SRC_MASK
// | PSYS_PART_TARGET_POS_MASK
// | PSYS_PART_TARGET_LINEAR_MASK
)
//end of particle settings
];
if ( AUTO_START ) llParticleSystem( particle_parameters );
}
link_message( integer sibling, integer num, string mesg, key target_key )
{
if ( mesg != CONTROLLER_ID ) { // this message isn't for me.

Bail

out.
return;
} else if ( num == 0 ) { // Message says to turn particles OFF:
llParticleSystem( [ ] );
} else if ( num == 1 ) { // Message says to turn particles ON:
llParticleSystem( particle_parameters + target_parameters );
} else if ( num == 2 ) { // Turn on, and remember and use the key
sent us as a target:
target_parameters = [ PSYS_SRC_TARGET_KEY, target_key ];
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llParticleSystem( particle_parameters + target_parameters );
} else { // bad instruction number
// do nothing.
}
}
}

Make a poseball
(from http://www.mermaiddiaries.com)
Poseballs...you see them everywhere. If you Right-click on a poseball and select "Sit
Here" (or the replacement text), your avatar will perform the animation contained in the
poseball. A poseball's animation may be a static pose, or it could be a moving
animation (like a dance, for example).
Poseballs are typically spheres about 0.25M in size. Some have writing above them
giving a hint of what they do, like "Sit", "M", "F", "Relax" or "Cuddle". Some poseballs
respond to chat commands, like "show" or "hide" to show or hide the poseballs.
We are going to create a poseball.
You need to go to a place where you can build.
First, click the Build button on the bottom of your screen and then click on the ground
to rez a Box.
Change the Building Block Type to "Sphere". Change the Size X, Y, and Z to 1.000.

Go to the Texture tab. Click on the picture above Texture. Click on "Blank" and "Select"
to pick a blank texture.
Click on the picture above Color. Pick a color (either pink or blue) and then click
"Select".
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Go to the Contents tab.
Look for the "Nyterave Anim8 Ball 2.1" script in the Poseball folder you picked up at
Sirena. Drag and drop the "Nyterave Anim8 Ball 2.1" script from your Inventory into the
Contents tab of the poseball.

You should see the words "Sit Here" appear at the top of the poseball.
Look for "Animated sit (bored)" animation file in the Poseball folder you picked up at
Sirena. Drag and drop the "Animated sit (bored)" animation from your Inventory into the
Contents tab of the poseball. (BTW, you can use any of the "Sit" animations. Im just using
this one because its a moving animation...)
Go to the General tab. Change the Name to "Tutorial Poseball".
That's it! You are now the proud owner of a giant poseball.
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Go ahead: Right-click on it and select "Sit Here". You should be sitting and looking
bored :)

Now, lets put the poseball on something. In this case, lets use a chair.
Look for the "Tutorial Chair" in the Poseball folder you picked up at Sirena. Drag and
drop the "Tutorial Chair" from your Inventory to the ground.

Move the poseball over to the chair. Because the poseball is so large, it will pretty much
cover the whole chair. Dont worry, theres a reason for all this
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Right-click on the poseball and select "Sit Here".
Depending on which way you were facing when you created the poseball, you will
probably end up sitting sideways or backwards. No problem...thats why we made the
poseball so large

Right-click in the middle of your avatar, around where the center of the poseball should
be. Select "Edit".
You should now be editing the giant invisible poseball!
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At this point, you can position or rotate the poseball as you need, while you are sitting
on the poseball. This makes things a lot easier to position...
To rotate the poseball, click on "Rotate (Ctrl)" at the top of the Edit window. Then use
the color wheels to rotates your avatar.

Once you are facing the right way, click on "Position" at the top of the Edit window.
Then use the color arrows to move your avatar into position.
Once you are done, click "Stand Up" at the bottom of the screen.
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We still have a giant poseball, so let's shrink it down to size...
Right-click on the poseball and select "Edit".
Go to the Object tab. Change the Size X, Y, and Z to 0.250M.

If you plan on taking the chair into your Inventory, you should link the poseball to the
chair.
Just Right-click on the poseball and select "Edit" to edit the poseball. Then press and
hold [Shift], and Left-click on the chair.
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Select the "Tools" option from the top menu bar, and "Link". Now the poseball is part of
the chair.
To take the poseball/chair into Inventory, just Right-click on the poseball/chair and
select "Take".
Lets take a quick peek inside the script...
// 2007 Tali Rosca
// This code can be used and redistributed freely.
// This is a minimal demonstration of how to make a poseball.
default
{
state_entry()
{
// We need a sit target to be able to see who's actually sitting.
// ... and you probably need it to adjust exactly where people end up when
sitting anyway.
// The llEulerToRot... is a way to let you write normal degrees, rather
than the internal format LSL uses.
llSitTarget(<0, 0, 0.5>, llEuler2Rot(<0, 0, 90> * DEG_TO_RAD));
}
// Triggered on several interesting "major" events happening to the prim
changed(integer change)
{
// Filter things so we only look at sit and stand up.
if (change & CHANGED_LINK)
{
// Find out who's sitting. llAvatarOnSitTarget will be null if it was
actually somebody standing up.
key sitter = llAvatarOnSitTarget();
if (sitter != NULL_KEY)
{
// Make the ball invisible:
llSetAlpha(0.0, ALL_SIDES);
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// Animation permissions will automatically be granted when somebody is
sitting on the object,
// but the script still needs to acquire the permission.
llRequestPermissions(sitter, PERMISSION_TRIGGER_ANIMATION);
}
else
{
// No sitter. Make the ball visible again:
llSetAlpha(1.0, ALL_SIDES);
}
}
}
run_time_permissions(integer permissions)
{
// Good style to check if we actually got the right permissions, even
though if is not strictly necessary here,
// since we know we requested animation, and it will always be granted.
if (permissions & PERMISSION_TRIGGER_ANIMATION)
{
// Since the "sit" animation has high priority, we need to stop that one,
to make sure our animation
// will actually be able to play.
llStopAnimation("sit");
// And finally play the animation we wanted. "sleep" is one of the builtin, but it could also be a specific animation in the contents of the
poseball.
llStartAnimation("sleep");
// Note: The animation will automatically be stopped when the avatar
stands up again.
// If the animation permission had not been granted automatically to a
sitter,
// but through a dialog box (for example on touch) the animation will not
be stopped automatically.
// If that was the case, we would need to remember the animation playing,
and explicitly stop it ourselves.
}
}
}

Basic Pose Ball script
This script is almost as simple as can be, so it is easy to make changes to.
To use it:
1. Type the desired animation name into the script by replacing the default built-in:
"stand".
2. If the animation is not built-in, then drop the animation in the pose ball prim
3. Save(compile) the script in the pose ball prim
Now you are ready to sit on the pose ball
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//
//
on
//

Basic pose ball script. by Dora Gustafson, Studio Dora 2010
Free for anybody to read, copy, modify, compile, use, rip apart, trample
and flush
v1.3 with Set Click Action

string animation = "stand"; // name of built-in animation or animation in
prim inventory
default
{
state_entry()
{
llSitTarget( <0.0, 0.0, 0.01>, ZERO_ROTATION );
llSetSitText(llToUpper(animation));
llSetClickAction(CLICK_ACTION_SIT);
}
changed(integer change)
{
if (change & CHANGED_LINK)
{
key sitter = llAvatarOnSitTarget();
if(sitter != NULL_KEY) llRequestPermissions(sitter ,
PERMISSION_TRIGGER_ANIMATION);
else
{
if (llGetPermissions() & PERMISSION_TRIGGER_ANIMATION)
llStopAnimation(animation);
llSetAlpha(1.0, ALL_SIDES); // show prim
}
}
}
run_time_permissions(integer perm)
{
if ( perm & PERMISSION_TRIGGER_ANIMATION )
{
llSetAlpha(0.0, ALL_SIDES); // hide prim
llStartAnimation(animation);
llStopAnimation("sit");
}
}
}

Besides handling the animation, the script has only few features:
o
o
o
o
o

It hides the ball prim on sit and shows it on unsit
Sets SitText to the name of the animation
Sets "ClickAction" to Sit on a mouse click
Has neither hide or show on chat commands. This makes it "Low Lag"
Has no floating/hover text

Move objects from Second Life to OpenSim with TestClient.exe
Second Life doesn’t allow interactions with other grid, but you can export objects that
you have created and you can import them later in OpenSim.
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You can do this with some viewers as Phoneix, or use a non-graphical tool as TestClient.
TestClient is located in openmetaverse. It’s a command line program. To export an
object it goes like this:
Start program from DOS Command Prompt
C:\libomv-0.9.1\bin>TestClient

Logging in Second Life with your account
0 avatars online> login Name Surname Password https://login.agni.linden
lab.com/cgi-bin/login.cgi

Teleport avatar in the sim you want. You must provide name and coordinates details of
the sim.
1 avatars online> goto nomesim/128/128/21

Search for objects with name "Nico", which are located at a maximum distance of 20
meters from your Avatar
1 avatars online> findobjects 20 Nico
Object ‘PallaPistaNico’: 03c2222d-1ac8-4b74-8f7d-73371ae3048b
Object ‘PallaPistaNico’: 692d2fa2-399a-4de8-b362-95ca19bb843b
Object ‘PallaPistaNico’: 75ad684f-3a55-4cc1-a2c9-9e95df5aa1b0
Object ‘PallaPistaNico’: faabc870-363b-4adb-a3ad-affbaa03f724

Now you can export objects, including texture, on the XML file by providing the ID of
the object that you want to export.
1 avatars online> export 23c198c9-d200-4466-b512-2ff65801300b miooggetto.xml

Disconnect avatar from Second Life
1 avatars online> logout

Connect avatar in Craft-World
0 avatars online> login Name Surname Password http://craft-world.org:8002

Import object. Textures are imported and applied.
1 avatars online> import miooggetto.xml

Disconnect avatar from Craft-World
1 avatars online> logout
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Server component
OpenSim Standalone Hypergrid Installation on Ubuntu Server
In this tutorial I use this versions:
Ubuntu 12.04.1
Mono 2.10.8.1
MySQL 5.5.24
OpenSim 0.7.4
Webmin 1.600
I need to install Mono because OpenSim is written in Mono, the Microsoft .Net open
source clone by Novell.
MySQL is the database where OpenSim saves its data and Webmin is a web platform to
manage your linux server.
Well, let's start!
Download Ubuntu image: ubuntu-12.04.1-server-i386.iso
Create virtual machine or use a physical machime: CPU 2core, 2GB RAM, 60GB Disk
Install Ubuntu Server. Choose this settings:
Italiano
Nome host: MyOpensimServer
Utente root: root rootpwd
Utente: osuser userpwd
Partizionamento: Guidato - usa l'intero disco
Nessun aggiornamento automatico
Scegliere il software da installare: nessuno
Login from command prompt as root
$ sudo passwd root

Server must be connected to Internet. Updating the operating system:
$ sudo apt-get update
$ sudo apt-get upgrade

Install Mono and database:
$ sudo apt-get install mono-complete
$ sudo apt-get install mysql-server
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The installation of database asks for a password for the root user in the database:
MySQL User: root
Pwd: mysqlpwd
Create database for OpenSim installation:
mysql -u root -p -h localhost
mysql> create database opensim;
mysql> use opensim;
mysql> create user 'opensim'@'localhost' identified by 'osdbpwd';
mysql> grant all on *.* to 'opensim'@'localhost';
mysql> quit

Install Webmin:
$ sudo apt-get install openssh-server
$ sudo apt-get install perl libnet-ssleay-perl openssl libauthen-pam-perl
libpam-runtime libio-pty-perl apt-show-versions python
$ wget http://prdownloads.sourceforge.net/webadmin/webmin_1.580_all.deb
$ sudo dpkg -i webmin_1.580_all.deb

From a network pc, try to connect to webmin:
https://MyOpensimServer:10000/
Update webmin and all packages found:
$
$
$
$

sudo
sudo
sudo
sudo

apt-get clean
apt-get install localepurge
apt-get install deborphan
deborphan | xargs sudo apt-get -y remove –purge

Setting up the network card:
$ sudo nano /etc/network/interfaces
auto eth0
iface eth0 inet static
address 192.168.2.50
netmask 255.255.255.0
gateway 192.168.2.1
dns-nameservers 208.67.222.222 208.67.220.220

Nano commands to edit text are:
CTRL+R to insert text
CTRL+O to save
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CTRL+X to exit
$ sudo ifdown eth0
$ sudo ifup eth0

Install opensim:
cd /etc
$ sudo wget http://opensimulator.org/dist/opensim-0.7.4.tar.gz
$ sudo tar xvzf opensim-0.7.4.tar.gz
cd opensim-0.7.4/bin
cp OpenSim.ini.example OpenSim.ini

Setting up OpenSim. Edit OpenSim.ini file:
$ sudo nano OpenSim.ini
Include-Architecture = “config-include/StandaloneHypergrid.ini”

If use Hypergrid teleport, also modify:
[XEngine]
Enabled = true
AllowOSFunctions = true
LightShare functions?} {true false} true
AllowLightShareFunctions = true
Allow_osGetSimulatorVersion = true
Allow_osTeleportAgent = true

Edit config-include/StandaloneCommon.ini
;Include-Storage = "config-include/storage/SQLiteStandalone.ini";
StorageProvider = "OpenSim.Data.MySQL.dll"
ConnectionString = "Data Source=localhost;Database=opensim;User
ID=opensim;Password=osdbpwd;Old Guids=true;"

If use Hypergrid teleport, you must replace all the links, from 127.0.0.1 to the domain
with which it’s published, eg. quenya.no-ip.org, and edit texts and welcome description
of the Grid.
You can use a physics engine better than ODE for sim, Bulletsim. It’s activated by
uncommenting the line in Opensim.ini:
physics = BulletSim

Run Opensim.
$ cd /etc/opensim-0.7.4/bin
$ mono OpenSim.exe
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Configure first start:
New region name []: Isengard

Enter for rest of default values:
Estate owner first name [Test]: NooS
Estate owner last name [User]: Foster
Password: myavatarpwd
Email: noosfoster@gmail.com

If don’t show errors, prompt appears:
Region (Isengard) #

With a viewer, connect to the server at the link: http://MyOpensimServer:9000
To stop OpenSim.exe:
Region (Isengard) #quit

Server Commands
(from http://opensimulator.org)
Server commands are those you can type on the console to make the server do various
things.
Commands can be divided up into those that apply to the simulator (simulator
commands) and those that apply to grid services (service commands).
On a standalone system, both simulator and service commands will be available on the
single standalone system console.
On a grid architecture, the simulator commands will be available on the simulators,
whilst the service commands will be available on the ROBUST console.
Disclaimer: some commands may not work as expected, some may not work at all, and
there is a chance that you may even lose all your settings/contents. This summary
quickly goes out of date - the best place to find commands is by typing "help" on the
region console.
Except where noted, this list should be accurate for OpenSimulator 0.7.1 onwards.

Commands
General Server Commands
These commands are available in both simulator and robust consoles.
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General
 command-script [scriptfile] - Runs a command script containing console
commands.
 quit - shutdown the server.
 shutdown - synonym for quit.
Debug
 debug http [<level>] - Turn on/off extra logging for HTTP request debugging.
Only available on robust console from commit 94517c8 (dev code post 0.7.3.1).
Simulator Commands
General
 change region <region name> - subsequent commands apply only to the
specified region. If region name is "root" then all regions are selected
 create region [name] [filename] - Create a new region
 debug packet <level> - Turn on packet debugging, where OpenSimulator prints
out summaries of incoming and outgoing packets for viewers, depending on the
level set
 debug scene - Turn on scene debugging
 delete-region <name> - Delete a region from disk
 emergency-monitoring - turn emergency debugging monitoring mode on or off.
 export-map [<path>] - Save an image of the world map (default name is
exportmap.jpg)
 help [<command>] - Get general command list or more detailed help on a
specific command or set of commands
 link-mapping - Set a local grid co-ordinate to link to a remote hypergrid
 link-region - Link a HyperGrid region. Not sure how this differs from link-mapping
 modules list - List modules
 modules load <name> - Load a module
 modules unload <name> - Unload a module
 monitor report - Returns a variety of statistics about the current region and/or
simulator
 region restart abort [<message>] - Abort a scheduled region restart, with an
optional message
 region restart bluebox <message> <delta seconds>+ - Schedule a region
restart. If one delta is given then the region is restarted in delta seconds time. A
time to restart is sent to users in the region as a dismissable bluebox notice. If
multiple deltas are given then a notice is sent when we reach each delta.
 region restart notice <message> <delta seconds>+ - Schedule a region
restart. Same as above except showing a transient notice instead of a
dismissable bluebox.
 reload estate - reload estate data
 remove-region - remove a region from the simulator
 restart - Restarts all sims in this instance
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set log level [level] - change the console logging level only. For example,

off or debug. See Logging for more information.
set region flags <Region name> <flags> - Set database flags for region
set terrain heights <corner> <min> <max> [<x>] [<y>] - Sets the terrain
texture heights on corner #<corner> to <min>/<max>, if <x> or <y> are specified,
it will only set it on regions with a matching coordinate. Specify -1 in <x> or <y> to
wildcard that coordinate. Corner # SW = 0, NW = 1, SE = 2, NE = 3.
set terrain texture <number> <uuid> [<x>] [<y>] - Sets the terrain <number>
to <uuid>, if <x> or <y> are specified, it will only set it on regions with a matching
coordinate. Specify -1 in <x> or <y> to wildcard that coordinate.
show caps - show all registered capabilities URLs
NOTE: In OpenSimulator 0.7.1, "show capabilities" is shown as a result for help
command, but actually only "show caps" will be accepted. (#5467)
show
show
show
show
show
show
show
show

circuits - Show agent circuit data
connections - show connections data
http-handlers - show all registered http handlers
hyperlinks - list hg regions
info - show server information (version and startup path)
modules - show module data
neighbours - Shows the local regions' neighbours
pending-objects - show number of objects in the pending queues of all

viewers












show pqueues [full] - show priority queue data for each client. Without the 'full'

option, only root agents are shown. With the 'full' option child agents are also
shown.
show queues - Show queue data for agent connections.
show ratings - Show rating data
show region [region name] - Show region data (Region Name, Region UUID,
Location, URI, Owner ID, Flags)
show regions - Show regions data (Region Names, XLocation YLocation
coordinates, Region Ports, Estate Names)
show stats - show usefull statistical information for this server. See Frame Statistics
Values below for more information.
show threads - shows the persistent threads registered with the system. Does not
include threadpool threads.
show throttles [full] - Show throttle data for each client connection, and the
maximum allowed for each connection by the server. Without the 'full' option,
only root agents are shown. With the 'full' option child agents are also shown.
show uptime - show server startup time and uptime.
show version - show server version.
unlink-region <local name> - unlink a hypergrid region
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Appearance Commands
 appearance show - Show information about avatar appearance. Currently just
checks whether the baked texture is "OK" or "corrupt". Still in development. Only
exists in development code at the moment.
Archive Commands
 load iar <first> <last> <inventory path> <password> [<archive path>] Load user inventory archive. See Inventory Archives.
 oad oar [filename] - load an OpenSimulator archive. This entirely replaces the
current region. Default filename is region.oar. See OpenSim Archives.
 load xml2 [filename] - optional parameters not supported for XML2 format as
at 1-Jul-2008
 save iar <first> <last> <inventory path> <password> [<archive path>] Save user inventory archive. See Inventory Archives
 save oar [filename] - save the current region to an OpenSimulator archive.
Default filename is region.oar. See OpenSim Archives.
 save prims xml2 [<prim name> <file name>] - Save named prim to XML2
 save xml [filename] - save prims to XML
 save xml2 [filename] - save prims to XML (Format 2 - rearrangement of some
nodes, to make loading/saving easier)
Asset Commands
The fcache commands only currently appearance if you are using the fcache asset
cache. This is the default on OpenSimulator.
 fcache assets - Attempt a deep scan and cache of all assets in all scenes
 fcache clear [file] [memory] - Remove all assets in the cache. If file or
memory is specified then only this cache is cleared.
 fcache expire <datetime> - Purge cached assets older then the specified
date/time
 fcache status - Display cache status
 j2k decode <ID> - Do JPEG2000 decoding of an asset.
Config Commands
 config get [<section>] [<key>] - Get the current configuration, either for a
particular key, a particular section or the whole config.
 config save <path> - Save the current configuration to a file.
 config set <section> <key> - Set a particular configuration value. On the
whole, this is useless since neither OpenSimulator nor modules dynamically reload
config values.
 config show [<section>] [<key>] - Synonym for 'config get'
Land Commands
 land show - Shows all parcels on the current region.
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Object Commands
 backup - Persist currently unsaved object changes immediately instead of waiting
for the normal persistence call. This shouldn't normally be required - the simulator
persists region objects automatically at regular intervals and on shutdown.
 delete object creator <UUID> - Delete a scene object by creator
 delete object name [--regex] <name> - Delete a scene object by name.
 delete object outside - Delete all scene objects outside region boundaries. This
is currently if z < 0 or z > 10000. Object outside these bounds have been known to
cause issues with OpenSimulator's use of some physics engines (such as the
Open Dynamics Engine).
 delete object owner <UUID> - Delete a scene object by owner
 delete object uuid <UUID> - Delete a scene object by uuid
 edit scale <name> <x> <y> <z> - Change the scale of a named prim
 force update - Force the region to send all clients updates about all objects.
 show object name [--regex] <name> - Show details of scene objects with the
given name.
 show object uuid <UUID> - Show details of a scene object with the given UUID
 show part name [--regex] <name> - Show details of scene object parts with the
given name.
 show part uuid <UUID> - Show details of a scene object parts with the given
UUID
Script Commands
These currently only exist in git master OpenSimulator development code post the 0.7.2
release.
 scripts resume [<script-item-uuid>] - Resumes all suspended scripts
 scripts show [<script-item-uuid>] - Show script information. <script-itemuuid> option only exists from git master 82f0e19 (2012-01-14) onwards (post
OpenSimulator 0.7.2).
 scripts start [<script-item-uuid>] - Starts all stopped scripts
 scripts stop [<script-item-uuid>] - Stops all running scripts
 scripts suspend [<script-item-uuid>] - Suspends all running scripts
Terrain Commands
Note that some of these may require a sim restart to show properly.
 terrain load - Loads a terrain from a specified file.
 terrain load-tile - Loads a terrain from a section of a larger file.
 terrain save - Saves the current heightmap to a specified file.
 terrain fill - Fills the current heightmap with a specified value.
 terrain elevate - Raises the current heightmap by the specified amount.
 terrain lower - Lowers the current heightmap by the specified amount.
 terrain multiply - Multiplies the heightmap by the value specified.
 terrain bake - Saves the current terrain into the regions revert map.
 terrain revert - Loads the revert map terrain into the regions heightmap.
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terrain newbrushes - Enables experimental brushes which replace the standard



terrain brushes. WARNING: This is a debug setting and may be removed at any
time.
terrain stats - Shows some information about the regions heightmap for
debugging purposes.
terrain effect - Runs a specified plugin effect



Tree Commands
 tree active - Change activity state for the trees module
 tree freeze - Freeze/Unfreeze activity for a defined copse
 tree load - Load a copse definition from an xml file
 tree plant - Start the planting on a copse
 tree rate - Reset the tree update rate (mSec)
 tree reload - Reload copse definitions from the in-scene trees
 tree remove - Remove a copse definition and all its in-scene trees
 tree statistics - Log statistics about the trees
User Commands
 alert <message> - send an in-world alert to everyone
 alert-user <first> <last> <message> - send an an in-world alert to a specific
user
 bypass permissions <true / false> - Bypass in-world permission checks
 debug permissions - Turn on permissions debugging
 force permissions - Force permissions on or off.
 kick user <first> <last> [message]: - Kick a user off the simulator
 login disable - Disable user entry to this simulator
 login enable - Enable user entry to this simulator
 login status - Show whether logins to this simulator are enabled or disabled
 show users [full]- show info about currently connected users to this region.
Without the 'full' option, only users actually on the region are shown. With the 'full'
option child agents of users in neighbouring regions are also shown.
 teleport user <destination> - Teleport a user on this simulator to a specific
destination
ROBUST Service Commands
These can also be accessed on the simulator command console itself in standalone
mode.
Asset Service
 delete asset - Delete an asset from the database. Doesn't appear to be
implemented.
 dump asset <ID> - Dump an asset to the filesystem. OpenSimulator 0.7.3
onwards.
 show digest <ID> - Show summary information about an asset. From
OpenSimulator 0.7.3 onwards this will be renamed to "show asset"
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Grid Service
 set region flags <Region name> <flags> - Set database flags for region
 show region <Region name> - Show the details of a given region. This command
is renamed to "show region name" in development versions of OpenSimulator.
The following commands currently only exist in development versions of OpenSimulator
(post 0.7.3.1). These are currently found in the "Regions" help section.






deregister region id <Region UUID> - Deregister a region manually. This can

be helpful if a region was not properly removed due to bad simulator shutdown
and the simulator has not since been restarted or its region configuration has
been changed.
show region at <x-coord> <y-coord> - Show details on a region at the given
co-ordinate.
show region name <Region name> - Show details on a region
show regions - Show details on all regions. In standalone mode this version of the
command is not currently available - the simulator version of "show regions" is
used instead, which shows similar information.

User Service
 create user [first] [last] [passw] [RegionX] [RegionY] [Email] - creates
a new user and password or just: create user - and server prompts for all data
Note for use of create user in standalone mode: use the user default coordinates
of 1000,1000 for Start Region X and Y position otherwise server gives error of
"[LOGIN]: Not found region"




reset user password - reset a user's password.



login-text <text to print during the login>



show account <firstname> <lastname> - show account details for the given user

login-level <value> - Set the miminim userlevel allowed to login.
login-reset - reset the login level to its default value.

name


set user level <firstname> <lastname> <level> - Set UserLevel for the user,

which determines whether a user has a god account
Details of Terrain Module Commands
terrain load
Loads a terrain from a specified file.
Parameters
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filename (String)

The file you wish to load from, the file extension determines the loader to be used.
Supported extensions include: .r32 (RAW32) .f32 (RAW32) .ter (Terragen) .raw (LL/SL
RAW) .jpg (JPEG) .jpeg (JPEG) .bmp (BMP) .png (PNG) .gif (GIF) .tif (TIFF) .tiff (TIFF)
terrain load-tile
Loads a terrain from a section of a larger file.
Parameters


filename (String)

The file you wish to load from, the file extension determines the loader to be used.
Supported extensions include: .r32 (RAW32) .f32 (RAW32) .ter (Terragen) .raw (LL/SL
RAW) .jpg (JPEG) .jpeg (JPEG) .bmp (BMP) .png (PNG) .gif (GIF) .tif (TIFF) .tiff (TIFF)


file width (Integer)

The width of the file in tiles


file height (Integer)

The height of the file in tiles


minimum X tile (Integer)

The X region coordinate of the first section on the file


minimum Y tile (Integer)

The Y region coordinate of the first section on the file
terrain save
Saves the current heightmap to a specified file.
Parameters


filename (String)

The destination filename for your heightmap, the file extension determines the format to
save in. Supported extensions include: .r32 (RAW32) .f32 (RAW32) .ter (Terragen) .raw
(LL/SL RAW) .jpg (JPEG) .jpeg (JPEG) .bmp (BMP) .png (PNG) .gif (GIF) .tif (TIFF) .tiff (TIFF)
terrain fill
Fills the current heightmap with a specified value.
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Parameters


value (Double)

The numeric value of the height you wish to set your region to.
terrain elevate
Raises the current heightmap by the specified amount.
Parameters


amount (Double)

terrain lower
Lowers the current heightmap by the specified amount.
Parameters


amount (Double)

The amount of height to remove from the terrain in meters.
terrain multiply
Multiplies the heightmap by the value specified.
Parameters


value (Double)

The value to multiply the heightmap by.
terrain bake
Saves the current terrain into the regions revert map.
terrain revert
Loads the revert map terrain into the regions heightmap.
terrain newbrushes
Enables experimental brushes which replace the standard terrain brushes. WARNING:
This is a debug setting and may be removed at any time.
Parameters


Enabled? (Boolean)

true / false - Enable new brushes
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terrain stats
Shows some information about the regions heightmap for debugging purposes.
terrain effect
Runs a specified plugin effect
Parameters


name (String)

The plugin effect you wish to run, or 'list' to see all plugins
Details of Hypergrid Commands
For full details and explanations of Hypergrid Commands, see the Linking Regions
sections of the Installing and Running Hypergrid page.
show hyperlinks
This command will show a list of all hypergrid linked regions.
link-region <Xloc> <Yloc> <host> <port> <location-name>
 Use Xloc and Yloc that make sense to your world, i.e. close to your regions, but
not adjacent.
 replace osl2.nac.uci.edu and 9006 with the domain name / ip address and the
port of the region you want to link to
E.g. link-region 8998 8998 osl2.nac.uci.edu 9006 OSGrid Gateway
unlink-region <local region name>
This command will unlink the specified hypergrid linked region - be sure to use the exact
local name as reported by the "show hyperlinks" command.
Important Note
Due to a viewer bug, you can only TP between regions that are no more than 4096 cells
apart in any dimension. What this means in practice is that if you want to link to OSGrid,
you must have your own regions reachable from the (10,000; 10,000) point on the map,
which is where OSGrid is centered. Place your regions somewhere in the 8,000s or the
12,000s.
Frame Statistics Values
The labels of the Frame Statistics values shown by the console command "show stats"
are a bit cryptic. Here is a list of the meanings of these values:




Dilatn - time dilation
SimFPS - sim FPS
PhyFPS - physics FPS
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AgntUp - # of agent updates
RootAg - # of root agents
ChldAg - # of child agents
Prims - # of total prims
AtvPrm - # of active prims
AtvScr - # of active scripts
ScrLPS - # of script lines per second
PktsIn - # of in packets per second
PktOut - # of out packets per second
PendDl - # of pending downloads
PendUl - # of pending uploads
UnackB - # of unacknowledged bytes
TotlFt - total frame time
NetFt - net frame time
PhysFt - physics frame time
OthrFt - other frame time
AgntFt - agent frame time
ImgsFt - image frame time

Outworld client development
libopenmetaverse
(from http://lib.openmetaverse.org)
libOpenMetaverse is a collection of .NET libraries written in c# for interacting with 3d
virtual world simulators. The core library implements the protocol, networking and client
functionality.
Using the library is much like using any other .NET component, We adhere to the
Microsoft Framework Design Guidelines wherever possible and extensive API
documentation is available.
Additionally there are other assemblies used by the core library that can also be used
standalone

Building a bot
Bots, or Non-Player Characters (NPCs), represent instances where, instead of a user
controlling an agent represented as an avatar in-world, a program controls the agent.
This facility allows one to program humanoid figures for a variety of tasks. There are two
ways that bots can be coded: on a client or on the server where opensim is running.
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This tutorial covers only the former case: running code on the client, which
coincidentally may be the same computer where the server is located.
The following example is called "MyPetBot" and by building this source, and running the
resulting bin\MyPetBot executable that results in the bot logging into the world, and
then proceeding to follow whatever avatar is specified inside the code.
To build your pet bot, you will need to copy the following code and make sure to edit
the following parts:
1. In your C# solution, include the missing references
2. Enter the first name, last name, and password of the agent that will serve as a
bot
3. Specify the start location (X,Y,Z) for the bot
4. Specify your region server
// Need to add the following References if using VC# 2008:
// OpenMetaverse, OpenMetaverseTypes, System
// These can be found in your opensim\bin folder
using System;
using System.IO;
using System.Collections.Generic;
using System.Text;
using OpenMetaverse;
namespace MyPetBot {
class MyPetBot {
public static GridClient client = new GridClient();
// Enter the name of the agent that you wish to treat
// as a bot. For example" Test User"
// Also enter the login password for this agent
private static string first_name = "Test";
private static string last_name = "User";
private static string password = "test";
// Specify where the bot is to be logged in
public static Vector3 startLoc = new Vector3(128, 128, 22);
public static Vector3 pos = new Vector3();
public static int turn_count = 0;
// How far, in meters, the target AV can go before we start moving
private static float followDistance = 3;
// A boolean switch to enable or disable following
public static bool followon = false;
// This is the name of the agent to follow
public static string followName = "FirstName LastName";
public static void Main() {
// Enter the region name where the bot will log in
string startLocation = NetworkManager.StartLocation("Your Region",
(int)startLoc.X, (int)startLoc.Y, (int)startLoc.Z);
client.Network.OnConnected +=
new NetworkManager.ConnectedCallback(Network_OnConnected);
client.Settings.LOGIN_SERVER = "http://yourserver:port/";
string[] pointAtt = new string[8];
if (client.Network.Login(first_name, last_name, password,
"My First Bot", startLocation, "Your name")) {
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client.Network.OnConnected +=
new NetworkManager.ConnectedCallback(Network_OnConnected);
Console.WriteLine("Bot Login Message: " + client.Network.LoginMessage);
client.Appearance.SetPreviousAppearance(false);
}
}
public static void Objects_OnObjectUpdated(Simulator simulator,
ObjectUpdate update, ulong regionHandle, ushort timeDilation) {
if (followon == true) //Check to make sure we need to be following
{
//Exit this event if it's not an avatar update
if (!update.Avatar) { return; }
Avatar av;
client.Network.CurrentSim.ObjectsAvatars.TryGetValue(update.LocalID,
out av);
if (av == null) return;
if (av.Name == followName) {
pos = av.Position;
if (Vector3.Distance(pos, client.Self.SimPosition) > followDistance) {
int followRegionX = (int)(regionHandle >> 32);
int followRegionY = (int)(regionHandle & 0xFFFFFFFF);
int followRegionZ = (int)(regionHandle);
ulong x = (ulong)(pos.X + followRegionX);
ulong y = (ulong)(pos.Y + followRegionY);
turn_count++;
if (turn_count % 10 == 1) client.Self.Movement.TurnToward(pos);
if (pos.Z > 1) {
client.Self.AutoPilotLocal(Convert.ToInt32(pos.X),
Convert.ToInt32(pos.Y), pos.Z);
} else {
client.Self.AutoPilotCancel();
}
} else {
turn_count = 0;
client.Self.Movement.TurnToward(pos);
}
}
}
}
static void Network_OnConnected(object sender) {
Console.WriteLine("The bot is connected");
client.Self.Movement.AlwaysRun = false;
System.Threading.Thread.Sleep(3000);
followon = true;
client.Objects.OnObjectUpdated += new
ObjectManager.ObjectUpdatedCallback(Objects_OnObjectUpdated);
}
}
}

Logging Out
client.Network.Logout();
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Send an instant message
UUID target = new UUID("243dd044-1127-11dc-8314-0800200c9a66");
//That key goes no where,
//replace it with the avatar key of the person you want to IM
Client.Self.InstantMessage(target, "Hello, World!");

Say something inworld (chat)
Client.Self.Chat("Hey There World", 0, ChatType.Normal);

Respond to instant messages
// put this somewhere when you want to start processing instant messages
Client.Self.IM += new EventHandler<InstantMessageEventArgs>(Self_IM);
//(...) then define the Self_IM method
static void Self_IM(object sender, InstantMessageEventArgs
//there are a variety of InstantMessageDialog choices..
//MessageFromObject and MessageFromAgent would be the two
if (e.IM.Dialog == InstantMessageDialog.MessageFromAgent)
Client.Self.InstantMessage(e.IM.FromAgentID,
e.IM.Message, e.IM.IMSessionID);
//send them an instant message back
//(this thing will copy any message the bot recieves in
}
}

e) {
most common
{

an IM)

You can also emulate typing through IM as such:
string reply = "Hello World!"; //Message to send.
byte[] bucket = new byte[1];
//I'm not sure of the actual binaryBucket, but 1 seems to work just fine.
Client.Self.InstantMessage(Client.Self.Name, e.IM.FromAgentID,
"typing", e.IM.IMSessionID, InstantMessageDialog.StartTyping,
InstantMessageOnline.Online, Client.Self.SimPosition,
Client.Network.CurrentSim.RegionID, bucket); //Send the typing dialog.
//using System.Threading;
Thread.Sleep((reply.Length * 300));
//Sleep for a short amount of time, based on the length of the message.
// (.3 seconds per character.)
Client.Self.InstantMessage(e.IM.FromAgentID,
reply, e.IM.IMSessionID); //Send the message.

Example of how to accept group invitations, friendship offers, teleports, and inventory
offers.
static void Self_IM(object sender, InstantMessageEventArgs e) {
switch (e.IM.Dialog) {
case InstantMessageDialog.GroupInvitation:
Client.Self.GroupInviteRespond(e.IM.FromAgentID, e.IM.IMSessionID, true);
break;
case InstantMessageDialog.FriendshipOffered:
Client.Friends.AcceptFriendship(e.IM.FromAgentID, e.IM.IMSessionID);
break;
case InstantMessageDialog.RequestTeleport:
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Client.Self.TeleportLureRespond(e.IM.FromAgentID, e.IM.IMSessionID, true);
break;
case InstantMessageDialog.InventoryOffered: {
//accepting the inventory offer
Client.Self.InstantMessage(Client.Self.Name, e.IM.FromAgentID,
String.Empty, e.IM.IMSessionID,
InstantMessageDialog.InventoryAccepted,
InstantMessageOnline.Offline, Client.Self.SimPosition,
UUID.Zero, new byte[0]);
if (e.IM.BinaryBucket.Length == 17) {
//here we are getting the AssetType and the objectID,
// so this can be a bit more useful to you
AssetType type = (AssetType)e.IM.BinaryBucket[0];
UUID objectID = new UUID(e.IM.BinaryBucket, 1);
}
//declining the inventory offer
/*Client.Self.InstantMessage(Client.Self.Name, e.IM.FromAgentID,
* String.Empty, e.IM.IMSessionID, InstantMessageDialog.InventoryDeclined,
* InstantMessageOnline.Offline, Client.Self.SimPosition, UUID.Zero,
* new byte[0]);*/
break;
}
default:
break;
}
}

Respond to inworld chat
Client.Self.ChatFromSimulator +=
new EventHandler<ChatEventArgs>(Self_ChatFromSimulator);
static void Self_ChatFromSimulator(object sender, ChatEventArgs e) {
//process chat here! exaple:
client.Self.Chat(e.Message, 0, ChatType.Normal);
}

Teleport to another location
//With only a name of a sim and a location
Client.Self.Teleport("Ahern", new Vector3(128.0f, 128.0f, 50.0f));
//With the key of a landmark (new!)
Client.Self.Teleport(new UUID("The-key-of-a-landmark"));
//To your Home Location
Client.Self.Teleport(UUID.Zero);

You can also fire an event when a Teleport succeeds or fails:
client.Self.OnTeleport += new AgentManager.TeleportCallback(Self_OnTeleport);
//Definition of Self_OnTeleport:
static void Self_OnTeleport(string message,
AgentManager.TeleportStatus status,
AgentManager.TeleportFlags flags) {
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//message contains any messages regarding the teleport
//status is an enum of the current teleport status
//flags is various flags regarding the teleport
}

Move relative to its own position
OpenMetaverse.Vector3 pos = client.Self.SimPosition;
x = (int)pos.X + x;
y = (int)pos.Y + y;
client.Self.AutoPilotLocal(x, y, pos.Z);

Load and use a complete appearance from inventory
static void WearOutFit(string Item) {
//initialize our list to store the folder contents
LLUUID inventoryItems;
//make a string array to put our folder names in.
String[] SearchFolders = { "" };
//Next we grab a full copy of the entire inventory
//and get it stored into the Inventory Manager
client.Inventory.RequestFolderContents(
client.Inventory.Store.RootFolder.UUID,
client.Self.AgentID, true, true,
InventorySortOrder.ByDate);
//Next we want to step through the directory
//structure until we get to the item.
SearchFolders[0] = "Objects";
//Now we can grab the details of that folder and store it to our list.
inventoryItems = client.Inventory.FindObjectByPath(
client.Inventory.Store.RootFolder.UUID,
client.Self.AgentID, SearchFolders[0], 1000);
//now that we have the details of the objects folder,
//we need to grab the details of our torch.
SearchFolders[0] = Item;
inventoryItems = client.Inventory.FindObjectByPath(inventoryItems,
client.Self.AgentID, SearchFolders[0], 1000);
try {
client.Appearance.WearOutfit(inventoryItems, true);
} catch {
}
}
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